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Lesson Agenda

• This Lesson provides an introduction to the:
– Instructor and class participants
– Training site information
– Course:

— Audience
— Prerequisites
— Goal
— Objectives
— Methodology
— Materials
— Agenda

Siebel 8.1.x Business Automation   I - 2
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Instructor and Class Participants

• Who are you?
– Name
– Company
– Role

• What is your prior experience?
– Siebel applications
– Siebel Tools and configuration
– Relational database

• How do you expect to benefit from this course?
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Training Site Information

Rest rooms

Telephones

Fire Exits

Class duration and breaks

Meals and refreshments

Questions?
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Course Audience

• This course is designed for implementation team members 
who need to automate business processes in Siebel 
applications
– Developers
– Configurators
– Other implementation team personnel
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Course Prerequisites

• Siebel 8.0 Technical Foundations (required)
• Siebel 8.0 Fundamentals (recommended)
• Siebel 8.1.x Tools (recommended)
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Course Goal

• To enable participants to use the Siebel client and Siebel 
Tools to automate business processes in the Siebel 
application to meet common business requirements
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Course Objectives

• Create, test, and deploy Siebel workflow processes 
• Enable Siebel Inbox access for existing data types 
• Build validation rule sets for Siebel Data Validation 

Manager 
• Create, test, and deploy user-interactive automation using 

Siebel Task UI 
• Describe the role of scripting in Siebel business 

automation 
• Use Siebel SmartScript to script employee interactions 

with customers 
• Use Siebel State Model to enforce business requirements 
• Assign business data efficiently using Siebel Assignment 

Manager
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Course Methodology 

• Subject matter is delivered through: 
– Lecture and slide presentations 
– Software demonstrations 
– Class discussions
– Hands-on practices 
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Course Materials 

• Course content is delivered over five days
• Student Guide

– All slides presented during lecture
– Student notes with references to the Siebel Bookshelf 

documentation library
• Activity Guide

– Hands-on exercises and solutions
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Siebel Documentation

• Siebel applications are documented in Siebel Bookshelf, a 
searchable collection of guidebooks
– Bookshelf is also called Siebel Business Applications 

Documentation Library
– Updated regularly

• In the classroom, Siebel Bookshelf is available on Oracle 
Technology Network 
– www.oracle.com/technology/documention/siebel.html
– Make sure you are using the appropriate version of 

Bookshelf
— Example: Siebel 8.1

Siebel Documentation
References in the lessons to Siebel Bookshelf use the convention Bookshelf Title, “Chapter Name”.
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Feedback

• If you have feedback on this or other Siebel courseware, 
please email 
SIEBEL_CRM_CURRICULUM_WW@oracle.com
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Business Services and Workflow
• Lesson 1: Siebel Business Services
• Lesson 2: Building Siebel Workflow Processes
• Lesson 2a: Siebel Workflow Practices
• Lesson 3: Testing and Deploying Workflow Processes
• Lesson 4: Siebel Workflow Architecture
• Lesson 5: Building Robust Workflows
• Lesson 6: Invoking Workflow Processes:

Runtime Events and Custom Controls
• Lesson 7: Using Workflow Policies

Course Agenda 
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Other Automation Infrastructure
• Lesson 8: Configuring the Universal Inbox
• Lesson 9: Using Siebel Data Validation Manager

Task UI
• Lesson 10: Siebel Task UI
• Lesson 11: Creating a Task
• Lesson 12: Transient Business Components
• Lesson 13: Additional Task UI Configuration

Scripting
• Lesson 14: Introducing Scripting

Course Agenda
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Client Automation
• Lesson 15: SmartScript Overview
• Lesson 16: Creating a SmartScript
• Lesson 17: Advanced SmartScript Features
• Lesson 18: Siebel State Models

Assignment Manager
• Lesson 19: Introducing Siebel Assignment Manager
• Lesson 20: Creating Assignment Rules
• Lesson 21: Understanding Assignment Methodology
• Lesson 22: Configuring Assignment Manager
• Lesson 23: Invoking Assignment Manager

Course Agenda
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Summary

• This lesson provided an introduction to the:
– Instructor and class participants
– Training site information
– Course:

— Audience
— Prerequisites
— Goal
— Objectives
— Methodology
— Materials
— Agenda
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Practice 0 Overview: 
Preparing the Classroom Environment

This practice covers the following topics:
• Exiting any existing Siebel applications
• Running the classroom refresh utility to prepare the 

classroom for this course

Note: Successfully completing this practice is critical to ensure subsequent practices 
behave as expected.

Preparing the Classroom Environment
Practices for this and all other lessons are found in the course’s Activity Guide.
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Siebel Business Services
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Objectives

After completing this lesson, you should be able to:
• Describe a business service
• Describe the structure and role of property sets
• Use the business service simulator to test a business 

service
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Automating Business Processes

• A business process is a series of activities executed to 
achieve a specific business objective
– Example: the Quote to Cash business process (how an 

enterprise creates a quote and converts it to an order for 
submission)

• Automation options within the Siebel application can 
address such challenges as:
– Maintaining and standardizing consistent business 

processes across all business units
– Routing and assigning tasks accurately and efficiently
– Responding in a timely, effective manner to customer 

inquiries and service requests
– Assisting users with the implementation of best practices
– Offering consistent and personalized service to customers
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Siebel Automation Facilities

• Siebel applications include functionality to automate 
business processes:
– Workflow Processes

— Automate steps in a business process
– Tasks

— Guide users through a series of views to complete a step in a 
business process

– Assignment Manager
— Automates assignment of data (such as opportunities and 

service requests) to the desired people
– State Model

— Enforces a limited life cycle for select business entities
– SmartScript

— Guides an employee through complex customer interactions

Siebel Automation Facilities
The facilities listed in this slide are all topics in this course. Several other automation-related 
facilities, such as Siebel Inbox and Data Validation Manager, are also covered in this course. 
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Business Service

• Is a unit of functionality that is reusable and globally 
accessible
– Example: The ISS Shipping Cost Service computes shipping 

charges corresponding to a company’s shipping policies
• Enables business logic to be executed repeatedly in 

multiple different contexts
– Business logic is not restricted to a specific object (business 

component, applet, and so forth)

Business Service
There is no single Bookshelf reference for business services, but instead they are documented in 
the reference that is related to the business service functionality. For example, business services 
for sending emails or other communications are referenced in the Siebel Communications Server 
Administration Guide, and business services related to sales order processing are described in 
the Siebel Order Management Infrastructure Guide.
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Prebuilt Business Services

• Siebel repository contains many prebuilt business services 
to support processing in areas such as:
– Customer order management

— ISS Credit Check Service
— ISS Shipping Cost Service

– Enterprise application integration (EAI)
— EAI Siebel Adapter
— EAI HTTP Transport

– XML document processing
— XML Hierarchy Converter
— XML Converter

– Communications
— Outbound Communications Manager
— Inbound E-mail Manager
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Repository-Stored Business Services 

• Some business services are stored in the Siebel repository
– Siebel-developed business services

— Are written in C++
— Cannot be modified by customers

– Custom business services developed by users
— Are written in Siebel Visual Basic or eScript
— Are created and modified by customers using Siebel Tools

Custom 
business service
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Client-Stored Business Services

• Some business services are stored in the client database
– Siebel-developed business services
– Custom business services developed by users

• Client-stored business services
– Are written in Siebel Visual Basic or eScript
– Are created and modified by customers using the 

Administration - Business Services screen
– Are never executed if there is a repository-stored business 

service of the same name

Business services entered and 
administered in the Siebel client

Client-Stored Business Services
The term “client database” refers to tables in the Siebel database that store user data.
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Methods

• A business service consists of one or more operations 
called methods
– Each method has a set of input and output arguments, each 

with a specified type

AUT Calculator

Square Root

Add

Divide

Arg1
Number

Arg1
Number

Arg1
Number

Arg2
Number

Sum
Number

Result
Number

Result
Number

Arg2
Number

Business service

Input arguments
Method

Output arguments

Argument name

Argument 
type
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Identifying Methods for a Business Service

• In Siebel Tools, navigate to Business Service | Business 
Service Method

Name that appears in the 
client when selecting a 

business service method
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Identifying Arguments and Types for a Method

• In Siebel Tools, navigate to Business Service | Business 
Service Method | Business Service Method Arg

Arguments for 
Divide method
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Invoking a Method

• Involves:
– Assigning values to the input parameters

— Not all input parameters are required to have values
– Retrieving the values assigned to the output parameters

AUT Calculator

Length

Divide

Concatenate

Arg1
Number

Result
Number

Arg2
Number

5 2 2.5
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Property Set

• Is the in-memory data structure used to:
– Pass a set of input arguments into a method
– Receive a set of output arguments from a method

Output 
property 

set

Input 
property 

set

AUT Calculator

Length

Divide

Concatenate

Arg1
Number

Result
Number

Arg2
Number

5 2 2.5
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Property Set

• Represents data using name/value pairs
• Has two predefined properties: Type and Value
• Has an array for storing user-provided name/value pairs
• Is automatically created and populated when invoking 

most business services from a Siebel workflow or task

Type

Value

Arg1 5 
Arg2 2

Predefined 
property 
names

Values for predefined 
properties

Array of user-provided 
name/value pairs

Input property 
set 
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Testing a Business Service

• Use the business service simulator in the Siebel Client
– Navigate to Administration - Business Service > Simulator
– Select the business service and method
– Create the property set name/value pairs

— Optionally load data from an input file

Input 
property set 

Business service and method
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Testing a Business Service

• Use the business service simulator in the Siebel client
– Click Run on One Input
– Examine the output property set name/value pairs
– Optionally save the output to a file

Output property set
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Lesson Highlights

• A business service is a unit of functionality that is reusable 
and globally accessible
– Can be stored in the repository or in user database tables
– Consists of one or more methods

— Each method is specified by a set of input and output arguments

• A property set is an in-memory data structure consisting of 
name value pairs

• A business service
– Is invoked by passing in the input arguments in a property 

set
– Returns the output arguments in a property set

• Use the business service simulator to test a business 
service
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Practice 1 Overview: 
Simulating a Business Service

This practice covers the following topics:
• Importing a custom business service into the repository
• Examining the methods and arguments for a business 

service
• Using the business service simulator to test a business 

service
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Building Siebel Workflow Processes
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Objectives

After completing this lesson, you should be able to:
• List the types of workflow processes and workflow steps
• Create a new workflow process and configure business 

service, Siebel operation, and decision steps
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Workflow Process

• Is an ordered set of steps executed in response to a 
defined set of conditions

• Is used to automate parts of a business process in a 
Siebel application

Workflow Process
Bookshelf documents workflow processes in the Siebel Business Process Framework: Workflow 
Guide.
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Workflow Designer

• Siebel Tools includes a Workflow Designer used to create, 
examine, and modify Siebel workflow processes
– Contains a palette, workspace, and associated property 

windows

Palette of 
workflow steps

Properties window 
(displays properties 

of selected item)

Workspace for 
editing workflows

Multi Value Property Window 
(displays properties of child 

records of selected item)

Workflow Designer
The Workflow Designer is discussed in Bookshelf’s Siebel Business Process Framework: Workflow 
Guide, “For Developers: Basics of Building Workflow Processes”.
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Workflow Process Steps

• Siebel workflow processes consist of different types of 
steps

Sub process step

Decision 
point step

Business 
service step

User interact 
step

Start step

End step

eS
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Common Workflow Process Steps
Other step types and connectors, such as Sub-process, Stop  and Error Exception are covered in a 
later lesson. Task steps are used to embed Siebel Tasks in workflow processes. Tasks are covered 
later in this course.
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Common Workflow Process Steps

• All workflow processes have a:
– Start step
– End step

• Workflow processes often include the following common 
steps:
– Siebel operation step
– Business service step
– Decision point step
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Siebel Operation Step

• Performs the following operations on a business 
component:
– Insert
– Update 
– Delete
– Query

— NextRecord and PreviousRecord operations supported for 
iteration over multiple records returned by a query

Queries the Contact 
business component

Siebel Operation Step
QueryBiDirectional and Upsert operations are also supported.
Performing queries in workflows is covered in depth in a later lesson. 
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Business Service Step 

• Invokes a method of a business service 

Invokes the Truncate method of the 
StringManipulation business service

Business Service Step
StringManipulation is a user-provided business service that performs simple operations on string 
inputs, such as truncate, concatenate, or length. You will use this business service in one of this 
lesson’s practices.
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Decision Point Step

• Allows a workflow to branch to one of multiple steps based 
on the value of inputs 

If input = yes

If input = no

Decision Point Step
Notice that the Properties window does not reveal the decision logic. The branching logic associated 
with a Decision Point step is part of the connectors attached to the step, and will be discussed later in 
this lesson.
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Process Properties

• Process properties are variables that store inputs used by 
and outputs produced by workflow steps

• Each workflow process has a set of process properties that 
persist while the workflow process is executing
– Some are populated when the workflow process is invoked
– Some return data to the invoking workflow process or 

business service upon completion

Properties specific 
to this workflow

Default properties 
for all workflows
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Process Properties

• Provide inputs to workflow steps
• Receive outputs from workflow steps

– Can be used as inputs for subsequent steps
FirstName

LastName
ContactCode

StringManipulation

Length

Truncate

Concatenate

String1
String

String2
String

OutputString
String

Business 
service step

Process 
Properties
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Configuring a Siebel Workflow

To configure a new workflow process in the Siebel Tools
Workflow Designer:

1. Create a New Workflow Process
2. Specify Process Properties
3. Add Workflow Steps
4. Configure Workflow Steps
5. Validate the Workflow Process
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1. Create a New Workflow Process

• In Siebel Tools, select the Workflow Process object type
• Create a new workflow process definition

– Enter the process name
– Assign the process to a locked project
– Assign a business object

— Provides context for references to business components and 
fields

• Right-click and select Edit Workflow Process to invoke the 
Workflow Designer

1. Create a New Workflow Process
A business object must be specified whenever you use a workflow step (such as a Siebel Operation 
step) that references a business component. In addition if a workflow references a business object, 
then the workflow must be executed in the context of that business object.
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2. Specify Process Properties

• Select the Process Properties tab in the Multi Value 
Property Window (MVPW) to display the default process 
properties

• Edit the default set of process properties
– Add new process properties to store additional values 

created and used by the workflow steps
– Leave the default process properties unchanged

Default process properties 
for all workflows
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3. Add Workflow Steps

• Add a start and end step to the designer
– Drag steps from the palette to the workspace

• Add other steps as required
• Add connectors to sequence the steps

– Make sure that connector ends are anchored (red box 
appears)

Dynamic connectors are 
drawn automatically

Connector is anchored
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4. Configure Workflow Steps: Siebel Operation

• Specify the business component and operation
– Use the properties window

• Specify additional child arguments as required in the 
MVPW
– Examples: Field names, search spec input arguments, 

output arguments

Business 
component

Operation

Fields retrieved

4. Configure Workflow Steps: Siebel Operation
In the screenshot shown, the Search Spec Input Arguments tab is used to specify the search 
specification for a query operation. This topic will be covered in a later lesson.
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4. Configure Workflow Steps: Business Service

• Specify the business service name and business service 
method
– Use the Properties window

Business service 
and method
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4. Configure Workflow Steps: Business Service 
Specify Input and Outputs

• Specify inputs to use in the workflow
– Select the Input Arguments tab in the MVPW
– Define each input

• Specify outputs of the business service step
– Select the Output arguments tab in the MVPW
– Assign each output to a process property

Constant value 
assigned as input

Process property 
assigned as input

Output argument assigned 
to process property
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4. Configure the Steps: Decision Point Step

• Set conditions on each branch (connector) originating at 
the step:
– Select the connector
– Right-click and select Edit Conditions
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4. Configure the Steps: Decision Point Step
Set Condition

• Enter the condition criteria for each branch in the Compose 
Condition Criteria dialog box

• Do not create a condition criteria for the default branch
– Execution path taken if no other branches are satisfied

Does contact have 
a middle name
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5. Validate the Workflow Process

• Save configuration performed in the Workflow Designer
• Return to the Workflow Process List
• Right-click the workflow and select Validate
• Click Start to perform the validation checks

– Syntactic errors are displayed in the Errors window
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Additional Workflow Steps

• Siebel workflows may contain additional types of steps:
– Sub process

— Invokes another workflow process as a sub process
– User interact

— Navigates the user to a view and waits for user activity
– Wait

— Pauses the workflow for a specified period before proceeding
– Stop

— Stops the workflow process instance if a predefined exception 
occurs 

– Task
— Invokes a Siebel task

Additional Workflow Steps
Other Step Types
Sub process and stop steps are covered in a later workflow lesson, and Siebel tasks are covered later 
in the course.
User Interact Steps
User interact steps are used in Interactive Flow workflows (discussed in a later lesson). In most 
circumstances, Siebel Task UI should be used instead of Interactive Flow workflows. Task UI will be 
discussed in a later lesson.
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Workflow Modes

• Workflows have a mode property that describes their 
runtime behavior:
– Service Flow

— Executes a discrete set of steps and completes
— Is the default mode for a new workflow
— Cannot include wait or user interact steps

– Interactive flow
— Designed to navigate users through a set of views
— Is being replaced by Siebel tasks

– Long running flow
— Is a workflow that persists for some indeterminate period of time
— Can be paused and resumed as an inbox item
— Cannot include a wait step

– 7.0 flows 
— For backward compatibility: do not use for new workflows
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Lesson Highlights

• A workflow process is an ordered set of steps executed in 
response to a defined set of conditions
– Automates parts of a business process

• Siebel workflow processes consist of different step types
• Process properties are variables that store inputs used by 

and outputs produced by workflow steps
• Build a workflow process by:

– Creating a new workflow process
– Specifying the process properties
– Adding workflow steps
– Configuring each step
– Validating the workflow process
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Practice 2 Overview: 
Building Workflow Processes

This practice covers the following topics:
• Configuring a workflow process that includes business 

service steps
• Configuring a workflow process that includes a decision 

point step
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Siebel Workflow Practices
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Two Workflow Processes

• In the Siebel Workflow practices, create and modify two 
workflow processes:
– AUT Create Contact Identifier
– AUT Big Opportunity
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AUT Create Contact Identifier:
Functional Requirement

• For a Contact record:
– Construct an identifier for the contact using the first letter of 

the first name plus the last name
— Example: Mary Smith has identifier MSmith

– Put the result in an unused field that is displayed for the 
Contact 

— Use the Contact business component field Mail Stop, which is 
visible in the Contact Form Applet - Child

Contact Identifier 
constructed from 

First and Last Name
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AUT Create Contact Identifier:
Implementation

• Implement this workflow using a custom business service, 
AUT_StringManipulation
– Has three methods for strings:

— Concatenate: combines two strings
— Length: returns the length of a string
— Truncate: returns a substring of a specified length

— Characters can be removed from the right or left end of an input
string

• Use a Siebel Operation step to update the Mail Stop field

AUT Create Contact Identifier: Implementation
Truncate Method
Truncate takes the following input arguments:

• Input String: the string to be truncated
• Length: the length of the substring returned
• Direction: indicates which end of the string the returned substring is taken from; takes 

values Left (the default) and Right.
Workflow vs. Calculated Field
This workflow’s specific requirement could be implemented using a calculated business 
component (BC) field.  Such a field is calculated at runtime using an expression that uses other 
BC field values or system values, such as the current time.  To meet the requirement using a 
calculated field set the Calculated Value property for a new BC field to Left([FirstName],1)+[Last 
Name]. Left(), a built-in function, is similar to AUT_StringManipulation’s Truncate method.
If you wanted to store the identifier without run-time calculation, then you could create a field 
with pre-default value equal to the expression above.
Using a workflow rather than a calculated field would be appropriate if:

• You use a more complex algorithm to construct the identifier
• You need to create a unique contact identifier. A workflow could query for a matching 

identifier, and if found, could use an alternate algorithm for constructing a unique 
identifier.

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Oracle
 In

ternal &
 O

racle
 Aca

demy

Use
 O

nly



Siebel 8.1.x Business Automation   2a - 5

Copyright © 2010, Oracle and/or its affiliates. All rights reserved.

AUT Big Opportunity:
Functional Requirement

• For an Opportunity record:
– If Revenue is $1,000,000 or more, and Sales Stage is 

Submitted, Approved, or Rejected
– Then send an email notification to all members of the 

Opportunity’s sales team
• Email notification should include information on the 

Opportunity, such as name, revenue, primary on the sales 
team, and sales stage
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AUT Big Opportunity:
Implementation

• You will implement this workflow in stages:
– First version will test email capability
– Final version will add opportunity information to the email 

notification
• You will use the Siebel Communications Server to send 

email
– Enable the Communications Management component group

• The Communications Outbound Manager server 
component:
– Provides a business service interface
– Is used for outbound email, phone, fax, and other message 

types
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Outbound Communications Manager 
Business Service

• Uses the server component of the same name
• Has two methods that you will use to send Email:

– SendMessage
— Sends a test message with no substitutions
— You provide input arguments, including:

— List of recipient addresses
— Message
— Communications Profile name (discussed later)

– CreateRequest
— Creates a message that can include substitutions from the 

current object (Opportunity)
— You provide input arguments, including:

— Communications Profile name
— A communications Template name (discussed later)
— Recipient Group

Outbound Communications Manager Business Service
The Siebel Communications Server and the Outbound Communications Manager business 
service are documented in Bookshelf’s Siebel Communications Server Administration Guide. 
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Sending Email in a Workflow Process

• To send email from a Siebel workflow you must configure:
– The email server

— Create user accounts
— Lab environment includes hMailServer, a free third-party mail 

server
– Siebel Communications Server 

— Enable the Communications Management component group
— Create a Profile record that specifies email settings
— Create Communications Templates for email communications
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Communications Drivers and Profiles

• Siebel Communications Server accesses channels, such 
as email, fax, or messenger, through communications 
drivers
– Driver parameters specify protocols (for example, SMTP) 

and basic settings (channel type, character set, and so on)
• Profiles are associated with a driver and extend or override 

driver parameters

Communications
Driver

Communications
Profile

Profile and profile 
parameters for 

the Internet 
SMTP/POP3 
Server driver

Communications Drivers and Profiles
Communications drivers and profiles are configured in Administration - Communications > 
Communications Drivers and Profiles.  In a practice, you will create the Workflow Profile 
shown. This profile includes a from address that is used in all workflow-generated emails, as 
well as server names for the POP3 (inbound) server and the SMTP (outbound) server.
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Communications Templates

• Are used to create messages with substitutable fields
– Example: The AUT Big Opportunity workflow will use a 

template that puts opportunity information in an email 
notification message

Template 
includes 

substitutable 
fields

Fields are 
populated from 
current object 
(Opportunity)
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Testing and Deploying Workflow Processes
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Objectives

After completing this lesson, you should be able to:
• Test a Siebel workflow process using the workflow 

simulator
• Deploy a Siebel workflow process 
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Managing Siebel Workflow Processes

• Workflow processes differ from most other object 
definitions
– Are not compiled into a .srf
– Can be exported to and imported from XML files

• After a workflow process has been configured in Siebel 
Tools:
– Simulate the workflow
– Deploy the workflow

Workflow Simulator
Using the Workflow Simulator is covered in Bookshelf’s Siebel Business Process Framework: 
Workflow Guide, “For Developers: Testing a Workflow Process”.
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Workflow Simulator

• Use the workflow simulator to verify that the workflow 
performs as desired 
– Workflow simulation is controlled in Siebel Tools
– Workflow is executed in an instance of a Siebel client

— Tools and the Siebel client must be connected to a common 
database

DB

Workflow Simulator (continued)
Using the Workflow Simulator is covered in Bookshelf’s Siebel Business Process Framework: 
Workflow Guide, “For Developers: Testing a Workflow Process”.
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Enabling Workflow Simulation

• Configure the connection to 
the Siebel run-time 
instance
– In Siebel Tools, select 

View > Options > Debug
— Simulator shares the 

parameters used by the 
Tools debugger

– Specify the run-time 
Siebel instance

– Provide a valid login

Parameters are used by 
the Workflow Simulator 

and the Tools script 
debugger

Enabling Workflow Simulation
Debug Options
In View > Options > Debug, set:

• Executable: Location of siebel.exe for the Siebel Mobile Web Client or Siebel Developer 
Client

• CFG file: Location of Mobile/Developer Web Client configuration file
• Browser: Location of browser executable file
• Working directory: The Mobile/Developer Web Client binaries directory
• Arguments: Use the default, /h.  This starts the client in Debug mode. In Debug mode, the 

Siebel client displays detailed debugging information when it encounters a run-time error.
• Login information: Login name, password, and data source
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Testing a Workflow Using the Workflow Simulator

The steps to test a workflow process in the Siebel Tools
Workflow Simulator are:

1. Specify the Test Record
2. Start the Simulator
3. Start the Simulation
4. Execute the Workflow

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Oracle
 In

ternal &
 O

racle
 Aca

demy

Use
 O

nly



Siebel 8.1.x Business Automation   3 - 7

Copyright © 2010, Oracle and/or its affiliates. All rights reserved.

1. Specify the Test Records

• In the Siebel client, create test records to support the 
simulation
– Use Help > About Record to determine the Row Id

• In Siebel Tools, enter the Row Id of the test record as the 
Default String for the Object Id process property
– When the workflow is invoked in production, the Row Id of 

the record is passed in as an input argument
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2. Start the Simulator

• Make sure that all instances of the Siebel client application 
are closed

• Right-click the Workflow Designer workspace and select 
Simulate
– The Workflow Designer displays the workflow in the 

simulator window
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3. Start the Simulation

• Click the Start Simulation button in the simulation toolbar
– Use View > Toolbars > Simulation to display the simulation 

toolbar
• A new instance of the Siebel client is launched

Wait until the Siebel client 
application starts and displays 
the Workflow Simulator view

Start simulation
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4. Execute the Workflow

• Execute the workflow in either:
– Single step mode using the Simulate Next button
– Continuous mode using the Complete Simulation button

• Verify that the workflow branches correctly at decision 
steps

Simulate next Complete simulation
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4. Execute the Workflow: Using the Watch 
Window

• Inspect the watch window to verify that process properties 
have the expected values
– Values of user added process properties can be edited 

during a simulation

Inspect process properties 
in the watch window
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4. Execute the Workflow: Completing the 
Simulation

• Complete the simulation
– Use either Simulate Next or Complete Simulation buttons

• Verify that the final values of process properties are correct
• Click the Stop Simulation button
• Inspect the client and verify the result

Stop simulation
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Workflow Simulator Considerations

• Cannot simulate workflow processes that invoke server 
components
– Must test these workflows directly in the Siebel Web Client

• Cannot simulate workflows with run-time events on start 
steps (discussed in a subsequent lesson)

• Can simulate workflows with user interact steps
– Requires the developer to perform the activity in the client 

application to allow the simulation to proceed

Workflow Simulator Considerations
One exception to the restriction on simulating workflow processes with server components is 
Assignment Manager. A later lesson covers this Siebel functionality, which can be invoked 
through the Business Service Simulator using the business service Synchronous Assignment 
Manager Requests. This business service can be simulated in a local, thick client, even though 
Assignment Manager invocation typically requires server components.
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Deploying Workflow Processes

• Transfers the workflow from the repository to run-time 
tables to make it available for use

• Consists of:
– Developer setting the workflow to complete in Siebel Tools

— Publish the workflow
— Check in the workflow’s project

– Administrator activating the workflow in the run-time client
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Developer: Publish the Workflow

• In Siebel Tools, click Publish on the Workflow toolbar
– Sets the status to Completed

— Prevents any further editing of the workflow process
– Makes the workflow available for activation 

Publish
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Developer: Check In the Workflow Process

• In Siebel Tools, check in the completed workflow process 
to the server repository
– Siebel Web Client can now access the workflow
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Administrator: Activate the Workflow

• In the Siebel Web Client, activate the workflow
– Navigate to Business Process - Administration > Workflow 

Deployment
– Select the newly deployed workflow and click Activate

— Transfers the workflow definitions in the repository tables into
corresponding run-time tables

Activated 
workflows appear 

in the Active 
Workflow 

Processes applet
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Workflow Publishing and Activation: Summary

Repository Runtime Tables

1. Publish marks 
workflows 

Completed and 
updates their 
definitions in 
Repository

2. Definitions read 
from repository

3. When a 
workflow is 
activated, 

definition is 
written to 

runtime tables

Developer in 
Siebel Tools

Administrator 
in Siebel Client

Workflow Publishing and Activation: Summary
Publish changes the workflow status from In Progress to Completed and writes the workflow 
definition to repository tables in the developer’s local database. After the developer has 
completed publishing from Siebel Tools, the administrator continues the process in the client 
application. Step two shows that workflow definitions are read from the repository and displayed 
in the Workflow Deployment view. In step three, the administrator uses Activate, which writes 
the workflow definition to the runtime tables. Here they are stored as XML, for optimum 
performance, along with their deployment parameters. 
This picture is simplified by omitting the Check In, which is done by the developer. This step 
copies the workflow repository information from repository tables in the developer’s local 
database to corresponding tables in the server database.  An administrator on the production 
server would have to activate these checked in workflows.

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Oracle
 In

ternal &
 O

racle
 Aca

demy

Use
 O

nly



Siebel 8.1.x Business Automation   3 - 19

Copyright © 2010, Oracle and/or its affiliates. All rights reserved.

Using Publish/Activate to Speed Workflow 
Testing

• Developers can deploy and activate a workflow process 
from Siebel Tools to expedite testing 

• In Siebel Tools, click Publish/Activate on the Workflow 
toolbar
– Sets the workflow status to Completed
– Transfers the workflow definitions in the repository tables into

corresponding run-time tables
— The client used for testing must use the same database as 

Siebel Tools
Publish/Activate
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Deployment Considerations

• Publish and activate all child workflows (sub processes) 
first to make them available to the deployed workflow

• Compile any new repository objects referenced in the 
deployed workflow such as business components, fields, 
and views
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Revising Workflows

• Workflows are versioned
• To revise a workflow:

– In Siebel Tools, selected the desired workflow (check out if 
necessary)

– Click the Revise button in the Workflow toolbar
— Creates a copy of the workflow

— Increments the version number
— Sets the Status to In Progress

– Edit, test, and deploy the workflow

Revise
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Administering a Revised Workflow

• In the Siebel Web Client, activate the workflow as before
– Sets the deployment status of the prior version to Outdated

• After being activated the new version will be invoked
– Any instances of the prior workflow version running at the 

time of activation run to completion
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Lesson Highlights

• Use the workflow simulator to verify that the workflow 
behaves as designed
– Workflow simulation is controlled in Siebel Tools
– Workflow is executed in an instance of a Siebel client

• Deploy a workflow to make it available for use in the run-
time client
– In Siebel Tools, publish the workflow
– In the run-time client, activate the workflow to make the 

workflow available for invocation
• Revise a deployed workflow to edit it

– Creates a new version
– Increments version number
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Practice 3 Overview: 
Testing Siebel Workflow Processes

This practice covers the following topics:
• Testing a Siebel workflow process 
• Importing and exporting a workflow process
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Siebel Workflow Architecture
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Objectives

After completing this lesson, you should be able to:
• Describe the Siebel Workflow run-time architecture
• Describe the run-time environment of a workflow process
• Execute a workflow using the business service simulator
• Monitor workflow execution
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Executing Siebel Workflows

• All Siebel workflow processes are executed by the 
Workflow Process Manager business service
– Is often referred to as the Workflow Engine

• This business service has two methods used to execute a 
workflow process
– RunProcess: execute a specified workflow process for a 

given Row Id
– RunBatch: execute a specified workflow process for a set of 

records designated by a search specification

Executing Siebel Workflows
Reference
The Siebel Workflow run-time architecture is discussed in Bookshelf’s Siebel Business Process 
Framework: Workflow Guide, “Introduction to Workflow Processes”.
Workflow Process Manager (Server Request)
The Workflow Process Manager (Server Request) business service executes the Workflow 
Process Manager method RunProcess in the Workflow Process Manager server component. 
Technically, Workflow Process Manager (Server Request) is a second business service that 
executes a workflow process, but it offers a subset of Workflow Process Manager functionality.
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Invoking a Workflow Process in the Business 
Service Simulator

• The Workflow Engine can be invoked in the Business 
Service Simulator
– Is an alternative way of testing new workflows

— Can be used for workflows that call server components

Business service that 
executes workflow processes 

Provide the name of 
the workflow process 
and an Object Id as 

input arguments

Invoking a Workflow Process in the Business Service Simulator
This method allows you to test workflows that can’t be simulated. For example, a workflow 
process that requires the use of server components cannot be simulated, but could be tested in 
the business service simulator.
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Server Components and the Siebel Workflow 
Engine

• Server components that invoke the Workflow Process 
Manager business service are:
– Application Object Managers (AOMs)
– Workflow Process Manager (WfProcMgr)
– Workflow Process Batch Manager (WfProcBatchMgr)

Workflow Process
Manager

business service

WfProcBatchMgr
server component

Workflow Process
Manager

business service

Application Object
Manager

Workflow Process
Manager

business service

WfProcMgr
server componentServer

Request
Broker
server

component

Server Components and the Siebel Workflow Engine
Component Groups
AOM server components belong to an application-specific component group. For example, the 
Siebel Call Center AOM, SCCObjMgr_enu, belongs to the Call Center component group. Both 
Workflow Process Manager and Workflow Process Batch Manager belong to the Workflow 
Management component group.
Terminology
This lesson will sometimes refer to the Workflow Management server components by their 
aliases, WfProcMgr and WfProcBatchMgr, to avoid confusion with the Workflow Process 
Manager business service.
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Workflow Process
Manager

business service

WfProcBatchMgr
server component

Workflow Process
Manager

business service

Application Object
Manager

Workflow Process
Manager

business service

WfProcMgr
server componentServer

Request
Broker
server

component

Application Object Managers (AOMs)

• Can execute a workflow by:
– Calling the Workflow Process Manager business service 

directly
• Usually execute workflow processes that are invoked by a 

run-time event
– Covered in a subsequent lesson

Application Object Managers (AOMs)
Remote Processing Mode
The AOM will dispatch workflow execution to the Workflow Process Manager server 
component if workflow’s triggering runtime event has Processing Mode set to Remote 
Synchronous or Remote Asynchronous. Configuring runtime events in workflow processes is the 
topic of a later lesson.
Server Request Broker 
The Server Request Broker is a server component that routes requests between clients and server 
components. For more details on this component, refer to Bookshelf’s Siebel System 
Administration Guide, “Siebel Server Infrastructure Administration”.
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Workflow Process
Manager

business service

WfProcBatchMgr
server component

Workflow Process
Manager

business service

Application Object
Manager

Workflow Process
Manager

business service

WfProcMgr
server componentServer

Request
Broker
server

component

Workflow Process Manager (WfProcMgr)

• Is a server component configured to run the Workflow 
Process Manager business service efficiently
– Belongs to the Workflow Management component group

• Uses the Siebel Object Manager framework
– WfProcMgr has access to business objects and runtime 

events
• Calls the Workflow Process Manager business service

Workflow Process Manager (WfProcMgr)
Executing a Workflow Process in WfProcMgr
There are several ways to execute a workflow with WfProcMgr:

• By a runtime event, where the event’s processing mode is set to Remote Synchronous or 
Remote Asynchronous 

• Through a workflow policy
• In a script

The first two of these ways are discussed in later lessons.
WfProcMgr/WfProcBatchMgr Caveat
Business services calling UI functions, including navigation functionality such as the User 
Interact step, are not supported when workflows are run by WfProcMgr or WfProcBatchMgr.
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Dispatching Workflow Execution to WfProcMgr

• The AOM will dispatch workflow execution to WfProcMgr 
by:
– Calling the Workflow Process Manager (Server Request) 

business service, which dispatches execution to WfProcMgr 
by way of the Server Request Broker component

– If the workflow’s Processing Mode is Remote Synchronous 
or Remote Asynchronous

— Processing Mode is a property of the workflow’s Start step

Dispatching Workflow Execution to WfProcMgr
If Processing Mode is Remote Synchronous, then the request to the Workflow Process Manager 
server component is for synchronous execution. Control will be returned to the user session after 
the workflow completes.  If Processing mode is Remote Asynchronous, then the request will be 
for asynchronous execution, and the user session will proceed while the workflow executes.
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Workflow Process
Manager

business service

WfProcBatchMgr
server component

Workflow Process
Manager

business service

Application Object
Manager

Workflow Process
Manager

business service

WfProcMgr
server componentServer

Request
Broker
server

component

Workflow Process Batch Manager 
(WfProcBatchMgr)

• Is a server component configured to execute the Workflow 
Process Manager business service on multiple objects

• Uses the Siebel Object Manager framework
• Requires a workflow process name and a search 

specification identifying objects to run workflow on
– Example: Process Name is AUT Create Contact Identifier 

and search specification is “[LastName]=‘B*’ ”

Workflow Process Batch Manager (WfProcBatchMgr)
A workflow batch request may be submitted as a server request in the Administration - Server 
Management screen. For details, refer to Bookshelf’s Siebel Business Process Framework: 
Workflow Guide, “For Developers: How Workflow Processes Are Designed” and Siebel System 
Administration Guide.
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Synchronous versus Asynchronous Execution of 
Workflows

• Synchronous workflow execution occurs in the AOM or 
WfProcMgr
– Can be triggered by an action on the part of the user:

— Directly by clicking a button or menu item
— Indirectly by performing a record or applet operation 

– User is forced to wait until the workflow completes (or 
pauses)

— Hourglass icon appears

• Asynchronous workflow execution occurs in WfProcMgr or 
WfProcBatchMgr

Synchronous versus Asynchronous Execution of Workflows
Examples of synchronous workflow execution:

• In response to a runtime event, such as a record being written
• By a custom control, such as a button.

Example of asynchronous workflow execution:
• By a workflow policy in response to a condition being met, such as a time interval elapsing
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Other Workflow Management Server Components

• Generate Triggers
• Workflow Monitor Agent
• Workflow Action Agent
• Workflow Recovery Manager

– Identifies workflows interrupted due to server failure
– Forwards these workflows to a workflow engine to resume 

execution

Used with Workflow Policies 
(discussed in a subsequent lesson)

Workflow 
Management 
component 

group
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Enabling Workflow Management Server 
Components 

• Navigate to Administration - Server Configuration > 
Enterprises > Component Groups

• Enable the Workflow Management component group on 
the enterprise

• Assign and enable the component group on a server

Enabling Workflow Management Server Components 
If the Workflow Management component group is not enabled as part of installation, it can be 
enabled using the Administration - Server Configuration screen.
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Workflow Process Run-Time Environment: 
Input and Output Arguments

• The Workflow Process Manager business service invokes 
a workflow process with the method RunProcess with:
– Input arguments

— Process Name: name of the workflow process
— Object Id: the current Row Id

– Output arguments
— Error Code: a code designating an error condition
— Error Message: a string describing an error condition

Workflow Process
Manager

RunProcess
Process Name

Object Id

Error Code

Error Message

Workflow Process Run-Time Environment: Input and Output Arguments
Error handling is discussed in the next lesson.
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The Role of a Workflow’s Business Object

• The Row Id of the current record is passed to the 
RunProcess business service method

• The method queries the primary business component (BC) 
of the workflow process’ business object for a matching 
Row Id

• Example: 
– RunProcess is passed the input arguments:

— Object ID: 1-YR1
— Process Name: AUT Create Contact Identifier

– AUT Create Contact Identifier workflow has Business Object 
property = Contact

– The primary BC of the Contact business object is the Contact 
BC

– RunProcess queries the Contact BC for Row Id = 1-YR1
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Caveats on Business Components

• A workflow process can use any BC that is a child or 
primary BC of the workflow’s Business Object property

• To access any other BC, use a Sub Process step
– Sub process workflow operates on a business object that 

accesses the desired BC

Child BCs

Primary BC
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Workflow Monitoring

• Navigate to Business Process - Administration > Workflow 
Deployment
– Select the active workflow process
– Set the monitoring level in the active workflow process as 

required
— The value assigned is used whenever the workflow process is 

invoked or resumed
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Monitoring Level

• Set monitoring level to record the needed amount of detail
– Performance will degrade as the amount of detail increases

Levels Record 
Process 
Instance

Record 
Step 
Instance

Record 
Process 
Properties

0-None N None None

1-Status Y None None

2-Progress Y All steps None

3-Detail Y All steps All steps 

4-Debug Y All steps All Steps

Data is written at 
the completion of 

the workflow

Data is written 
after each step
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Monitoring Workflow Execution

• To examine a workflow’s execution:
– Set the workflow’s Monitoring Level above “0 – None”
– Execute the workflow
– Navigate to Administration - Business Process > Workflow 

Instance Monitor > Aggregate Data
— Identify the correct instance and explore workflow and step data
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Lesson Highlights

• Workflow processes are executed by the Workflow 
Process Manager business service

• Server components that call the Workflow Process 
Manager business service are:
– Application Object Managers (AOMs)
– Workflow Process Manager server component
– Workflow Process Batch Manager server component

• Most new workflow processes should have a Workflow 
Mode of Service Flow

• A workflow process can use any business component (BC) 
that is a child or primary BC of the workflow’s Business 
Object property
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Practice 4 Overview: 
Exploring Siebel Workflow Architecture

This practice covers the following topics:
• Execute the Workflow Process Manager business service
• Run a Workflow Process Batch Manager job
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Building Robust Workflows
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Objectives

After completing this lesson, you should be able to:
• Use a Sub Process step in a workflow
• Handle errors in a Siebel workflow process
• Query in a Siebel Operation step
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Building Robust Workflows

• To produce more robust, scalable workflow processes, 
use:
– Sub Process steps

— Package workflow steps for reuse
– Error handling

— Anticipate and handle errors in the workflow
— Respond correctly to system errors

• Querying is supported in workflows
– Preferable to scripting
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Sub Process Steps

• Allow a segment of a workflow process to be bundled for 
reuse in other workflows
– Used for a sequence of steps that is repeated in other 

workflow processes
– Can use the calling workflow process’ process properties

• Can be executed as a "stand-alone" workflow process
• Example: The eSales - Checkout Process calls several 

sub processes

Step that 
calls a sub 

process

Sub Process Steps
Sub Process Steps are documented in the Siebel Business Process Framework: Workflow Guide, 
“About Workflow Process Step Types”.
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Creating a Sub Process: Step Properties

• Create the sub process the same way as any other 
workflow

• When creating the calling workflow process in the 
Workflow Designer:
– Insert a Sub Process step
– Set the step’s Name and Sub Process Name properties
– Double-click the step to open the sub process in the 

Workflow Designer 
Insert Sub 

Process step

Set step 
properties
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Creating a Sub Process: Input and Output 
Properties

• Input and output arguments for a Sub Process step are 
specified in the Multi Value Property Window (MVPW)

• Can map the parent workflow’s process properties to Sub 
Process input arguments

• Can map Sub Process output arguments to parent process 
properties

Input Argument 
values for a Sub 
Process step… Can be process properties 

of the calling workflow  
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Passing Data to a Sub Process by Reference

• By default, input arguments are passed to a sub process 
step by value
– Values are copied to a separate instance in the sub process 

and copied back upon completion of the sub process
• For passing sizeable hierarchy type properties, such as 

large property sets, pass by reference
– Pass a pointer to the argument, rather than copying values

• In the sub process workflow, set the Pass By Ref 
Hierarchy Argument property to TRUE
– All hierarchical input arguments to the workflow will be 

passed by reference

Passing Data to a Sub Process by Reference
Input and output arguments to a workflow have a Data Type property, which may have a value 
of Hierarchy. The Pass By Ref Hierarchy Argument workflow property only affects input 
arguments of that type.
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Error Handling

• Workflows may encounter errors:
– User-defined errors

— Example: An incorrect or outdated recipient address when 
sending email

– System errors
— Example: When attempting to send email, the mail server may 

be down

• If the error is not handled, then workflow execution will 
stop and an error message will be displayed to the user (if 
any)

• Siebel Workflow includes two mechanisms for handling 
errors in workflow processes:
– An Error Process
– An Error Exception connector

Error Handling
Error handling in workflows is documented in the Siebel Business Process Framework: 
Workflow Guide, “For Developers: How Workflow Processes Are Designed”.
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Error Process Name Workflow Property

• Is a workflow to handle all errors in a parent workflow 
process
– Any error that occurs in the parent workflow will cause the 

error workflow to be called
– Error workflow can try to handle the error condition

— Example: wait for 30 seconds and then resend email

• To use an error workflow:
– Create the error workflow 
– Set the Error Process Name property in the parent workflow

WF that will run when 
parent encounters an 

error

Parent workflow
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Error Exception Connector

• Use an Error Exception connector to try handling an error
– Subsequent steps can attempt recovery from the error

• Attach to Business Service or Siebel Operation step
– Define connector conditions to specify the error

— Similar to defining connector conditions for a Decision Point step
– Example: On send email failure, wait and resend

— Use Error Exception connector to avoid suspension of workflow

Error 
Exception 
connector

Set connector 
condition(s)

Error Exception Connector
The workflow segment terminated with a stop step will stop execution on the error specified by 
the connector condition shown on the right.  In this example, the error is considered 
unrecoverable.
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Stop Step

• If a Stop step terminates an Error Exception branch, set 
the step’s Error Code property to return a descriptive code
– Returned to the caller of the workflow (if any)
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Workflow Behavior on Error Conditions

• If no error handling is specified for a workflow, then on 
error:
– Execution of the workflow stops
– Workflow state is set to “In Error”
– Error code is returned to the caller of the workflow process

• If an error process is specified for the workflow and:
– The error process reaches its End step, then the calling 

workflow continues from where the error occured
– A different error occurs in the error process workflow, then:

— Parent workflow is suspended and remains in “In Error” state
— A new error code is returned to the caller of the parent workflow
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Errors in Sub Processes

• A Sub Process step may encounter an error
• If the sub process does not handle the error with an error 

process or Error Exception connector, then the sub and 
parent process terminate execution
– Error code is returned to the caller of the parent process

• If the sub process has an error process defined and:
– The error process handles the error successfully by reaching 

its End step, then:
— The sub process executes from the step where the error 

happened
– A different error occurs in the error process workflow, then:

— Sub process and parent exit and have state “In Error”
— New error code is returned to the caller of the parent workflow
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Querying in Workflow Processes

• Siebel Workflow supports querying using a Siebel 
Operation step

• A query creates a record set containing matching records
– Use NextRecord and PreviousRecord Siebel operations to 

navigate a record set
• There are two query Operations:

– Query: only supports navigation with NextRecord
– QueryBiDirectional : supports NextRecord and

PreviousRecord

Siebel operations 
used in queries

Querying in Workflow Processes
Bidirectional Query
QueryBiDirectional, must be used if you wish to move backwards through a record set using 
PreviousRecord. The record set returned by Query only supports forward movement using 
NextRecord.  
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Looping Through a Record Set

• Siebel operations have two output arguments that can be 
used to control looping through the record set
– Query operation has an output argument, NumAffRows, that 

specifies the number of rows matching the query
– NextRecord and PreviousRecord have an output argument,

NoMoreRecords, that is set to TRUE when the end of the 
record set is reached

• Map these output arguments to process properties, which 
can be used in Decision Step connector conditions

NumAffRecords

NoMoreRecords noRecords

MatchingRecords

Output Arguments Process Properties
Example usage: don’t loop if

MatchingRecords is zero

Example usage: don’t loop if
noRecords is TRUE

Looping Through a Record Set
The process property names shown in the diagram are examples, and are meant to suggest their 
use.
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Query and Looping Example

2. Query generates a record set 
and outputs to process property

MatchingRecords

1. Process property
noRecord is initially 

set to FALSE 

3. Branch taken if
MatchingRecords > 0 

AND noRecord = FALSE

4. NextRecord Siebel 
Operation sets noRecord to 

TRUE if no more records

5. Default branch taken if 
query returns no records 
OR at end of record set

Query and Looping Example
Process Properties for Queries
A workflow that loops through a record set will use two process properties: one to record the 
number of records returned by the query, and the other to indicate if there are no more records to 
process in the record set. In the example above, noRecord is a process property that is initially 
set to FALSE and then set to the output argument of the NextRecord step.  This process property 
will remain FALSE until NextRecord determines that the record set has no more records. The 
second process property, matchingRecords, is not shown in the example above. This numeric 
property is initially zero, and is set equal to the number of records returned by the query through 
the NumAffRecords output argument. The branch logic in step 3 has been simplified to use this 
output argument, but it will actually use the process property matchingRecords instead.  
End Step
The example workflow shows an end after the loop, but there is no requirement that the 
workflow process terminate after looping through a record set. Additional workflow logic could 
follow the exit from the loop.
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Setting a Search Specification

• Set the search parameters for a query in the MVPW:
– Filter Business Component: the name of the queried 

business component; on left side of the search specification
– Type: type of search specification - Literal or Expression
– Expression Business Component: if Type is Expression, then 

the fields that appear on the right side of the search 
specification are from this business component

– Search Specification: the search specification
• Example: search for accounts for a specified contact

Search specification evaluates to:
[Account.Id] = [Contact.Account Id]

Setting a Search Specification
Filter Business Component
An important restriction on the value of the filter business component is discussed in an 
upcoming slide.
Example
In the example shown, fields of the Filter BC, Account, appear on the left hand side of the search 
specification. Because Type has value Expression, fields that appear on the right hand side 
belong to the Expression BC, Contact. 
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Search Specification Syntax

• Search specifications use the same operators and 
expressions as queries in the Siebel Client or Tools
– Operators: =, <>, >, <, IS NULL, IS NOT NULL, AND, OR, 

and so on
• Special syntax for search specifications:

– Surround search specification with double quotes
– Use brackets, [], to refer to fields

— Example: [Last Name]
– Use & to refer to process properties

— Example: [&Object Id]
– Use single quotes, ', to specify string literals

— Example: "[Last Name] LIKE 'Z*' "
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A Restriction on Query Operations

• A Query step can only query a child business component 
of the workflow process’ Business Object
– Example: A workflow that acts on Opportunity cannot query 

on the Asset Mgmt - Asset business component
— Asset Mgmt - Asset is not a child BC of the Opportunity 

business object

Asset Mgmt - Asset is not a 
child BC of the Opportunity 

business object
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Querying the Primary Business Component

• A workflow process cannot query on the workflow’s 
primary business component
– Example: if a workflow has Business Object = Opportunity, 

then it cannot query for Opportunities with Name LIKE 'A*'
• Workaround to allow queries on the parent/primary BC:

1. Create a new child business component that uses the same 
base table as the primary business component

— Example: Create a new business component Opportunity No 
Link that uses S_OPTY, which is the base table for Opportunity

2. Add fields to the new child BC for all parent fields required in
the query or loop operations

— Example: create Name field and others as needed in 
subsequent operations on the record set

3. Add the new BC as a child BC of the business object

Querying the Primary Business Component
The new child business component does not need a link definition, which is why the example 
child BC is named Opportunity No Link.
Alternatives to Querying the Primary Business Component
Many times a query on a primary business component is unnecessary. For example, consider a 
workflow process acting on Service Request (SR) that queries for SRs older than three years 
with no resolution, then loops through the record set and sets the State of each SR to Inactive. 
An alternative would be a workflow that operates on a single SR, designated by the Object Id 
process property. This workflow simply sets the SR State to Inactive. Execute this workflow by 
executing a Workflow Process Batch Manager job with a search specification that looks for 
records older than three years with no resolution. This alternative would not require the 
configuration given here.
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Lesson Highlights

• Use Sub Process steps to call a workflow process from a 
parent workflow
– Can reuse functionality
– Reduces complexity of workflows

• Define input and output arguments for a Sub Process step
– Can pass process properties from the parent workflow

• Handle errors in workflow processes using:
– An error process: tries to handle all errors in a workflow
– An Error Exception connector 

— Is a branch from a Siebel Operation or Business Service Step
— May have conditions

• A query in a workflow returns a record set
– Use NextRecord and PreviousRecord to access the records
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Invoking Workflow Processes:
Runtime Events and Custom Controls
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Objectives

After completing this lesson, you should be able to:
• List several ways to invoke workflow
• Invoke a workflow process using a run-time event
• Invoke a workflow process using a custom control
• Invoke a workflow process in a script
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Invoking Workflow Processes

• A workflow process can be invoked by a variety of 
mechanisms 
– Run-time events                                              
– Custom buttons and menu items
– Workflow policies

— Covered in the next lesson
– Programmatically, from a script

Invoking Workflow Processes
Invoking Workflows from a Script
A common way to invoke a workflow process from a script is to execute the RunProcess method 
of the Workflow Process Manager business service.  This course, in the scripting section, 
includes a practice where you will execute a business service method from a script.
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Run-Time Events

• Are a mechanism that allows customer-configured 
processing to be triggered by user activity

• Consist of:
– A specification of some user activity such as:

— A record being updated
— Navigating to or from an applet

– The resultant processing:
— Execution of a workflow process
— Calls to one or more business services

— Known as an action set

Run-Time Events
Run-time events were introduced as part of Siebel Personalization and are described in 
Bookshelf’s Siebel Personalization Administration Guide, “Tracking Run-Time Events”.
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Run-Time Events: Object Types

• Can be defined for three types of objects:
– Application

— Examples: logging in, logging out
– Applet

— Examples: displaying an applet, displaying a record
– Business component

— Examples: Querying, deleting a record, setting a field value

• Are fired when a user performs the corresponding activity
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Business Component Events

• Business component events often come in pairs, such as:
– PreDelete/Delete
– PreSetField/SetField
– PreWriteRecord/WriteRecord

• The Pre- event is fired immediately prior to the Object 
Manager executing the operation
– Example: PreWriteRecord executes before a record is saved

— Allows for possible verification of field values

• The other event is fired immediately after the object 
manager executes the action
– Example: WriteRecord executes custom processing after the 

record is written
— Allows for follow-on processing after a record is saved
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Adding a Run-Time Event to a Workflow Process

• A run-time event can be added to a workflow process as a 
condition on the connector out of a:
– Start step 

— Used to invoke the workflow
– Wait step

— Used to resume the workflow
– User interact step

— Used to resume the workflow

Add run-time 
event here

Add run-time 
event here

Adding a Run-Time Event to a Workflow Process
Reference
Adding run-time events to workflow processes is discussed in Bookshelf’s Siebel Business 
Process Framework: Workflow Guide, “For Developers: Understanding How Workflow 
Processes Are Designed”.
User interact steps
User interact steps are a part of Interactive Flow workflows, which have been mostly supplanted 
by Siebel Task UI. Task UI is covered in later lessons.
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Using a Run-Time Event to Invoke a Workflow

• Required steps for using a run-time event to invoke a 
workflow process are:
1. Add the Run-Time Event
2. Publish and Activate the Workflow
3. Reload Run-Time Events
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1. Add the Run-Time Event

• Create the workflow process
• Select the connector to attach the run-time event

– Must originate from a Start, Wait, or User interact step
• In the Properties window, specify the triggering event
• Caution: A workflow with a run-time event on the start step 

cannot be tested with the workflow simulator

1. Select the connector 

2. Specify the event type, business 
component, and event to monitor 
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2. Publish and Activate the Workflow

• In Siebel Tools, publish the workflow
• In the Siebel client, activate the workflow 
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2. Deploy and Activate the Workflow: Run-Time 
Events

• Activating the workflow automatically registers the run-time 
event and associated workflow with the Siebel run-time 
event engine
– Creates an action set that invokes the Workflow Process 

Manager

Row ID of 
activated workflow

Business Service and 
method to invoke

Arguments 
to pass in

2. Deploy and Activate the Workflow: Run-Time Events
The context of the Workflow Process Manager business service RunProcess method, shown in 
the lowest highlighted box, is a single name/value pair. The parameter name is ProcessName and 
its value, as shown above, is 1-3XTJ.  This value is the Row Id of the workflow in the Workflow 
Deployment Definition table, S_WFA_DPLOY_DEF. This table holds definitions for all 
activated workflows. The action set, with these values, is created when you reload run-time 
events.
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3. Reload the Run-Time Events

• Navigate to Administration - Runtime Events > Events
• Select Menu > Reload Runtime Events

– Updates the run-time event engine with the new run-time 
event

– Not necessary to query for the specific run-time event

Run-time event created by 
activating the workflow process 
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Deactivating a Workflow Invoked by a Runtime 
Event

Recommended practice for deactivating a workflow process that is
triggered by a runtime event:

1. Deactivate the workflow in the Workflow Deployment > 
Repository Workflow Processes view

2. Remove the event record if no other action sets are associated 
with it 

3. Reload runtime events

Right-click active 
workflow and select 

Deactivate Process…

And then reload 
runtime events

Deactivating a Workflow Invoked by a Runtime Event
The diagram shows a workflow being deactivated in the Administration - Business Process > 
Workflow Deployment > Repository Workflow Processes view, and runtime events being 
reloaded in the Administration - Runtime Events > Events view.
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Invoking Workflows Using a Custom Control

• User explicitly clicks a custom button or menu item to 
invoke the workflow

• Configuration involves applet user properties

Custom menu item that 
invokes a workflow 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Oracle
 In

ternal &
 O

racle
 Aca

demy

Use
 O

nly



Siebel 8.1.x Business Automation   6 - 15

Copyright © 2010, Oracle and/or its affiliates. All rights reserved.

Invoking a Workflow Using a Custom Menu Item

• Create a Command object
– Specify a value for the Method property

• Add an Applet Method Menu Item to reference the 
Command
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Invoking a Workflow Using a Custom Menu Item

• Add a new Applet User Property that associates the 
workflow to be invoked with the new named method

Invoke this business 
service and method and …

… pass in these pairs of 
argument names and values
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Invoking a Workflow Using a Custom Button

• Create a custom Control for the button
– Specify a value for the Method Invoked property

• Add a new Applet User Property that associates the 
workflow to be invoked with the new named method

Create an applet user property specifying the workflow 
to execute when the named method is invoked

Specify a user-defined name for a 
Method to invoke on the control
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Invoking a Workflow Process Programmatically

• The Workflow Process Manager business service can be 
invoked in a script
– Use the InvokeMethod() method
– Pass a workflow process name and Object Id as input 

arguments
• Script excerpt:

Invoking a Workflow Process Programmatically
The script excerpt shown is in eScript, a scripting language similar to JavaScript used in Siebel 
server scripts. The syntax and methods used in this script are described in Bookshelf’s Siebel 
eScript Language Reference.
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Lesson Highlights

• A workflow process can be invoked by a variety of 
mechanisms: 
– Run-time events                                              
– Custom buttons and menu items
– Workflow policies
– In a script using a business service

• Run-time events are a mechanism that allows customer-
configured processing to be triggered by user activity

• A workflow can be invoked using a custom menu item or a 
custom control, such as a button:
– Use Siebel Tools to create required object definitions

• Invoke a workflow in a script by invoking the Workflow 
Process Manager business service’s RunProcess method
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Practice 6 Overview: 
Executing Workflow Processes

This practice covers the following topics:
• Configuring email in Siebel applications
• Invoking a workflow using a run-time event
• Using a communications template and sending email in a 

Siebel workflow
• Invoking a workflow from a custom menu item
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Using Workflow Policies
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Objectives

After completing this lesson, you should be able to:
• Create a workflow policy that invokes a workflow process 

in the Workflow Process Manager server component
• Enable the workflow policy using workflow server 

components
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Asynchronous Workflow Processing

• Some workflows need to be executed asynchronously
– They might run for a long time and should not execute in the 

user’s object manager
– They might need to wait for the invoking condition to be 

satisfied for some period of time
— Example: If a service request of critical severity remains 

unassigned for more than two hours, notify the service manager 
and set SR priority to Highest

• Workflow policies are a mechanism for asynchronous 
execution of workflow processes
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Workflow Policies

• A workflow policy is a rule consisting of:
– One or more policy conditions
– A policy action

• The action is invoked when all conditions are true
• Example: When a service request Severity = Critical and

Substatus = Unassigned:
– Send an urgent message to the service manager

Conditions:
Substatus = Unassigned
Service Request Severity = Critical

Conditions:
Substatus = Unassigned
Service Request Severity = Critical

Actions:
Update Priority to Highest
Send message to service manager

Actions:
Update Priority to Highest
Send message to service manager

IF True… then execute

Workflow
Policy

Workflow
Policy

Workflow Policies
Workflow policies are documented in Bookshelf’s Siebel Business Process Framework: 
Workflow Guide, “Workflow Policies”.
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Workflow Policy Conditions

• A policy condition specifies a logical relationship between 
a workflow policy column and a value

• All policy conditions must be true for a condition to apply
• A policy may have a duration specified

– Conditions must apply for the duration before the action is 
executed 

Actions:
Update Priority to Highest
Send message to owner

Actions:
Update Priority to Highest
Send message to owner

then execute

Workflow
Policy

Duration = 2 hours

Workflow
Policy

Duration = 2 hours

Conditions:
Substatus = Unassigned
Service Request Severity = Critical

Conditions:
Substatus = Unassigned
Service Request Severity = Critical

IF True for at least two hours …

Workflow Policy Conditions
Workflow Policy Column
A workflow policy column is an object definition configured in Siebel Tools that identifies a 
column in a Siebel database table that can be monitored by a workflow policy. Configuring 
workflow policy columns is discussed later in this lesson.
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Workflow Policy Actions

• A workflow policy action is the response to be executed
• Consists of:

– Type of program to be executed
— Examples: Run workflow process, send email, send message 

broadcast
– One or more program-specific arguments

• Actions are defined separately
– Can be used in multiple workflow policies
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Workflow Process Manager

• Workflow policies use the Workflow Process Manager 
server component

• This component:
– Is optimized for executing workflows
– Behaves like an object manager

— Can access the business and data layers
— Does not have a user interface for direct user interaction

– Uses database triggers:
— A trigger is a process or a stored procedure attached to a 

database table that fires when a specified data modification 
event occurs

— Are created by the Generate Triggers server component
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Executing Workflow Policies: Overview

• Generate Triggers creates the database triggers required 
to monitor conditions in policies

• Workflow Monitor Agent checks for fired triggers
• Workflow Process Manager executes the workflow process

Workflow 
Monitor Agent

Server 
Request Broker

Workflow
Process Mgr

Siebel 
Database

Generate  Triggers S_ESCL_REQ

End-user activity or server process

EIM

Create triggers corresponding 
to policy conditions

Triggers fire when 
conditions are 
satisfied; insert 

record in 
S_ESCL_REQ

Retrieves records and 
executes the actionExecutes the workflow 

process specified in action

Executing Workflow Policies: Overview
After you create a workflow policy, specifying conditions and workflow policy actions, you will 
generate triggers and start a Workflow Monitor Agent.  The workflow policy executes as 
follows:

• When the workflow policy conditions are met, triggers fire.
• These triggers insert a record in S_ESCL_REQ identifying the records that meet the 

workflow policy condition(s).
• The Workflow Monitor Agent server component runs, often after a specified sleep interval, 

and scans S_ESCL_REQ.
• If the Workflow Monitor Agent finds new records in S_ESCL_REQ created by policies in 

the agent’s policy group, it executes the appropriate workflow policy action.
• If the action is to execute a workflow process, the Workflow Monitor Agent dispatches a 

request to the Workflow Process Manager server component by way of the Server Request 
Broker.

• The Workflow Process Manager server component executes the business service of the 
same name.
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Workflow Policy Groups

• A workflow policy group is a collection of workflow policies 
that are monitored as a group by a Workflow Monitor 
Agent process
– Typically workflow policies that can be monitored at the 

same frequency are assigned to the same policy group

Policies in the 
Marketing policy group

Workflow Policy Groups
Multiple Workflow Policy Groups
A workflow group can be made up of similar policies. This could mean all policies with a high 
frequency, or all policies dealing with integration, and so on. Alternatively, all policies could be 
bundled together. All the policies in a group are monitored concurrently.
Policies with similar time intervals are generally grouped together. By creating groups of 
policies with similar time intervals, you can assign the workflow policy group a Workflow 
Monitor Agent with a polling rate that matches the needs of the workflow policies. This results 
in a more efficient use of resources.
Multiple Workflow Monitor Agents
Each Workflow Monitor Agent is assigned one workflow policy group. The reasons to use 
multiple Workflow Policy Agents are:

• To shorten the time between when the policy event is triggered and when the Workflow 
Monitor Agent notices the event.

• To spread the workload across multiple application servers.
• To adjust the polling interval so that polling for non-critical policies does not prevent 

efficient processing of critical policies.
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The steps to implement a workflow policy are:
1. Create a Workflow Policy Group
2. Create a Workflow Policy Action
3. Create a Workflow Policy
4. Generate Database Triggers
5. Start the Workflow Monitor Agent

Implementing a Workflow Policy 
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1. Create a Workflow Policy Group 

• Navigate to Administration - Business Process > Policy 
Groups

• Create a new policy group
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2. Create a Workflow Policy Action 

• Navigate to Administration - Business Process > Actions
• Create a new action 

– Specify Run Workflow Process
• Provide workflow process as an argument

Specify the Run Workflow 
Process program

Specify the workflow 
process to invoke

2. Create a Workflow Policy Action
Workflow policy actions are events that occur when the conditions of their workflow policy are 
met. You must create the necessary workflow policy actions before creating the policy that will 
use the action. If the action calls a workflow process, the workflow must already be published 
and activated.
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3. Create a Workflow Policy 

• Navigate to Administration - Business Process > Workflow 
Policies

• Create a new policy
– Specify conditions
– Add one or more actions 

Create 
a policy

Create a 
condition

Associate an action 
that invokes the 

workflow process

3. Create a Workflow Policy
For a policy, at least one condition must be defined, which causes an action to start a workflow 
process. 
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3. Create a Workflow Policy: Set Duration 

• Set a duration for the workflow policy
– All conditions must be met and the policy duration must be 

satisfied to trigger the workflow policy actions
– Defaults to 0

— The workflow policy actions are triggered as soon as the policy 
conditions are met

3. Create a Workflow Policy: Set Duration
A workflow policy defines a duration, even if it is zero, to fire triggers in the database. Once the 
policy conditions have been met, and the duration has been exceeded, then the action occurs. 
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4. Generate Database Triggers 

• Run a Generate Triggers batch job to create database 
triggers corresponding to the policy conditions
– When a trigger fires against a Policy Condition, a record is 

inserted in the Escalation Request Table (S_ESCL_REQ)
– S_ESCL_REQ contains all the rows in the database that 

could trigger a policy to take action

Generate Database
Triggers

Record is inserted, 
updated, or deleted

S_ESCL_REQ
table is updated

4. Generate Database Triggers
Triggers
Triggers monitor the database for records with conditions that match the policies.
Changing Triggers
Triggers are visible in the server database if you use database tools. Do not change these triggers 
using database tools: they should only be modified by running a Generate Triggers job.
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4. Generate Database Triggers: Creating a Job

• Navigate to Administration - Server Management > Jobs
• Create a new job

– Select component/job Generate Triggers
– Specify job parameters

• Submit the job

Create new 
Job and 
select 

Generate 
Triggers

Click Submit Job to 
start Component task

Specify job 
parameters

4. Generate Database Triggers: Creating a Job
Privileged User
Credentials for a privileged user must be specified in order to allow the generation of triggers on 
the Siebel database tables. Most often the database owner for the Siebel database is specified.
Generate Triggers job parameters
The EXEC parameter must be set to TRUE for a Generate Triggers job so that the Generate 
Triggers component automatically creates the SQL script and applies it to the server database. 
You will do this during this lesson’s practice.
Mode Job Parameter
Another job parameter for  Generate Triggers is Mode (not shown above). By default, the 
Generate Triggers component will generate triggers for both Assignment Manager and 
Workflow (Mode = ALL). If you set Mode = WORK then just workflow triggers are generated. 
Mode = ASSGN will generate triggers for Assignment Manager only. Assignment Manager is 
covered later in this course.
Trigger SQL File
The SQL file generated is called trigger.sql and is located in the siebsrvr folder.
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5. Start the Workflow Monitor Agent

• Create a custom Workflow Monitor Agent component 
definition to specify a Workflow group
– Monitors all policies within a single Workflow group 

• Activate the new component definition to make it available

5. Start the Workflow Monitor Agent
Create a custom Workflow Monitor Agent (WMA) by copying the definition of the original 
WMA and modifying its parameters.  One important component parameter to set is Group 
Name, which specifies which workflow policy group will be monitored.
Note you must restart the Siebel Server to make the new component definition available.
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Verify the Workflow Policy 

• Create a test record (or modify an existing record) that 
meets the policy condition

• Wait for at least the policy duration
• Verify that the desired workflow actions are executed
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Extending Workflow Policies: The Problem

• Workflow conditions are composed from a pre-configured 
set of business component fields
– Conditions are composed in the Workflow Policies 

Conditions applet
• You may wish to create a workflow policy using a field that 

does not appear in the Condition Field drop down

Extending Workflow Policies
Extending workflow policies is documented in Bookshelf’s Siebel Business Process Framework: 
Workflow Guide, “Workflow Policies”.
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Extending Workflow Policies: Example

• You want to compose a workflow policy condition for a 
Contact using the contact's Account URL field

• Account URL does not appear in Condition Field drop 
down

Contact 
Account

Account  
URL

Account 
URL is not 
available
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Extending Workflow Policies: The Solution

• Use Siebel Tools to extend the pre-defined set of workflow 
policy objects

• Extend workflow policy functionality by extending the 
hierarchy of workflow policy object definitions:
– Can make new Condition Fields available in the Workflow 

Policy Conditions applet
– Can make new Actions available in the Workflow Policy 

Actions applet

Extending Workflow Policies: The Solution
Viewing Workflow Policy Object Types in Siebel Tools 
Use View > Options > Object Explorer to make workflow policy object types visible in the 
Siebel Tools Object Explorer. These object types are not shown by default.
Other Extensions
This section focuses on adding new Condition Fields to the Workflow Policy Conditions applet. 
Refer to Bookshelf’s Siebel Business Process Framework: Workflow Guide for details on how to 
make new Actions available in the Workflow Policy Actions applet.
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Object types used to expose new workflow policy condition
fields are:

Workflow Policy Object Types

Workflow Policy Object:
A Workflow Policy’s 

Business Object

Workflow Policy Component:
Business Components available 

for a Workflow Policy Object 

Workflow Policy Component Column:
Fields available in a Workflow 

Policy Component

Workflow Policy Column:
A table and column that can be accessed by 
a Workflow Policy Object and child objects

Workflow Policy Object Types
The types shown above are:

• Workflow Policy Object: corresponds to a policy’s Workflow Object value
• Workflow Policy Component: specifies the BCs that can be accessed through a Workflow 

Policy Object
• Workflow Policy Component Column: specifies the fields available in a Workflow Policy 

Component
• Workflow Policy Column: specifies a table and column that can be accessed by a 

Workflow Policy Object and child objects
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Workflow Policy Object Types Example

To have a Contact's Account URL available in workflow policy
conditions, the following objects must be defined:

Workflow Policy Object:
Contact

Workflow Policy Component:
Account

Workflow Policy
Component Column:

Account URL

Workflow Policy Column:
Account URL*

*Specifies Account URL table and
column (S_ORG_EXT and URL) 

Workflow Policy Object Types Example
One way to remember the workflow policy object types is to view the Workflow Policy Object 
hierarchy of types as analogous to Business Object > Business Component > BC Field. This 
hierarchy is in the business layer.  The Workflow Policy Column object maps the business layer 
to the data layer by mapping a Workflow Policy Component Column to a database table and 
column.
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Adding a New Policy Condition Field

To make a new column available in workflow policy conditions:
1. Identify the field’s database table and column
2. Create a Workflow Policy Column definition
3. Create a Workflow Policy Component Column definition
4. Compile and test 

Adding a New Policy Condition Field
The example given here and on the following slides is relatively modest: expose a new column 
in an existing Workflow Policy Component. Account is already defined as a child Workflow 
Policy Component of the Contact Workflow Policy Object, so only new Workflow Policy 
Column and Workflow Policy Component Column definitions need to be created.  Creating new 
Policy Components and Policy Objects requires a detailed knowledge of the underlying data 
model, specifically determining the primary/foreign key relationships between Siebel tables.  
This information can be found in Siebel Tools.
Details on defining new Policy Objects and Policy Components is found in the Siebel Business 
Process Framework: Workflow Guide, “Workflow Policies”.

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Oracle
 In

ternal &
 O

racle
 Aca

demy

Use
 O

nly



Siebel 8.1.x Business Automation   7 - 25

Copyright © 2010, Oracle and/or its affiliates. All rights reserved.

1. Identify the Field's Database Table and Column

• Use Siebel Tools to map a user interface (UI) control or 
business component field to a table and column
– Examine UI object, such as an Applet, to map a control to a 

BC field
– Examine a BC field definition to map to a table and column

BC field for 
UI control

BC for 
applet

Table and Column 
for BC field
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2. Create a Workflow Policy Column Definition

• Create a new Workflow Policy Column definition, 
specifying:
– Name
– Project
– Table name
– Column

• Allows column to be used in a Workflow Policy Component 
Column definition

Table and Column 
for BC field

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Oracle
 In

ternal &
 O

racle
 Aca

demy

Use
 O

nly



Siebel 8.1.x Business Automation   7 - 27

Copyright © 2010, Oracle and/or its affiliates. All rights reserved.

3. Create a Workflow Policy Component Column 
Definition 

• Create a new Workflow Policy Component Column 
definition for the appropriate Workflow Policy Object and 
Workflow Policy Component, specifying:
– Workflow Policy Column name

Use dropdown to 
select the name of 

the Workflow Policy 
Column created in 
the previous step
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4. Compile and Test Changes 

• Compile projects for all modified and new object definitions
• Check in changes to the server
• Verify that the field is available in the Workflow Policy 

Conditions applet
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Lesson Highlights

• A workflow policy is a rule consisting of one or more 
conditions and a policy action to be executed when the 
conditions are satisfied

• Workflow policies implement asynchronous execution of 
workflow processes

• Workflow policies require the use of:
– Generate Triggers to create the database triggers
– Workflow Monitor Agent to check for fired triggers
– Workflow Process Manager to execute the associated 

workflow policy 
• Create Workflow Policy object definitions to expose more 

database columns for use in workflow policy conditions
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Practice 7 Overview: 
Using Workflow Policies

This practice covers the following topics:
• Configuring a new workflow policy column
• Creating a workflow policy
• Administering workflow components
• Invoking workflow with a workflow policy
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Configuring the Universal Inbox
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Objectives

After completing this lesson, you should be able to:
• Describe the Universal Inbox
• Describe the underlying Universal Inbox architecture
• Configure the Universal Inbox
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The Universal Inbox

• Is a single screen designed to show all approval and 
notification items to a user

• Handles many different types of items
– For example, service requests, paused tasks, quotes, orders, 

or agreements awaiting approval, and so forth
• Is available from Inbox > Inbox Items List > My Inbox Items

A user’s Inbox may show service 
requests, paused tasks, and other 
items requiring the user’s attention

The Universal Inbox
Reference: “Administering and Using Inbox” in the Siebel Applications Administration Guide on 
Oracle Technology Network.
My Team’s Inbox Items: Similar to other views managed by Access Control, managers should have 
access to the “My Team’s Inbox Items” view, which shows all of the Inbox items of all of their 
reports.
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Inbox Types

• Determine the behavior of Inbox items of that type:
– The destination view when the user drills down on the Inbox 

item name
– Available actions for that Inbox item
– Whether the Inbox item is transferable
– Expiration time for that Inbox item
– And so forth

Inbox types specify an 
underlying business object, 
available actions, and more

Inbox Types
Configuring Inbox Types: Details of configuring Inbox types are covered later in this lesson.
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Inbox: User Activities

• Users take actions on Inbox items depending on the Inbox 
type

Set a priority

Perform an action (list 
depends on Inbox type)

Examine the Inbox history 
or detail of the item

Drill down on the item 
name for more information

Delete or Transfer an item 
(Availability depends on Inbox type)
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Inbox: Additional User Views

• The Completed Items List and Submitted Items List show 
submitted and completed items, respectively
– The Inbox item type and action taken determine whether an 

item is marked as completed
— For example, marking a service request as “Closed” should also 

make it “Completed”

• Submitted or Completed items cannot be updated by the 
user

Closed service requests are moved to the 
Completed Items List in this example

Inbox: Additional User Views
Marking an Inbox item Submitted or Completed: Details on marking an Inbox item submitted or 
completed are provided later in this lesson.
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Inbox: Administrative Views

• Application administrators use the Administration - Inbox 
screen to perform additional basic administration
– Examine all active, submitted, or completed Inbox items
– Administer Inbox types
– Delete submitted items

The Administration - Inbox screen 
looks similar to the Inbox screen, 
with the exception of the All Inbox 

Types view link

Administrators may delete or 
transfer Inbox items, if that 
functionality is available for 

that item type
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Inbox: Object Types

• Two object types are shown in the various Inbox views:
– Inbox Items are the base object type, and are shown in the 

Submitted Items List
— Every time an Inbox record is created or modified, it appears in

this list
— Every Inbox Item includes a table of name-value pairs to store 

user parameters, if desired
– Inbox Item Owners are child objects of Inbox Items, and 

represent the current state of the Inbox Item
— An Inbox Item may have multiple Inbox Item Owners
— Inbox Item Owners appear as records in the Inbox Items and 

Completed Items lists

• Administrators have the ability to delete Submitted Items
– Removes the Inbox Item and all its child Inbox Item Owners
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Example: Creating Object Types

• Example: A user creates a service request, and a runtime 
event assigns that service request to a technical support 
engineer
– The runtime event calls a business service, which creates an 

Inbox Item for the service request
— This appears in the technical support engineer’s Submitted 

Items list
– This business service also creates two Inbox Item Owners 

for this Inbox Item
— One for the technical support engineer, which appears in the 

technical support engineer’s Inbox Items list
— One for the technical support engineer’s manager, which 

appears in the manager’s Inbox Items list
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Example: Modifying Object Types

• Example: The technical support engineer resolves the 
issue and marks the service request Closed
– The Inbox Item’s status is updated
– The Inbox Item Owners are deactivated, which marks them 

as “Completed” and moves them to the Completed Items List
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Inbox: Inbound Architecture

• To add items to the Inbox, a workflow, runtime event, or a 
script calls methods of the Universal Inbox Business 
Service
– Also used to modify Inbox items if the feature object is 

updated
Feature
Object
Layer

Workflow Runtime
Event

Inbox

Universal Inbox Business Service
Inbox
Layer

Script
Workflow, runtime event, or 

script calls a method to create 
or update an Inbox Item

Feature Objects
(Tasks, Service Requests, Approvals)
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Universal Inbox Business Service Methods

• The Universal Inbox Business Service has methods to:
– Create, delete, update, or locate Inbox Items
– Modify Inbox Item Owners
– Invoke an Inbox action
– Check to see whether an Inbox item already exists for an 

object
– And more

— See notes for a complete list

Universal Inbox Business Service Methods
The methods available in the Universal Inbox Business Service are:

• CallAction: Invoke an Inbox Item’s action, as defined by the Inbox type.
• CreateInbox: Create one or more Inbox Items and Inbox Item Owners.
• CreateInboxEx: Create a single Inbox Item and Inbox Item Owner.
• CreateInboxItem: Create one or more Inbox Items with no owners. These only appear in the 

Submitted Items list.
• CreateInboxOwner: Create one or more Inbox Item Owners for an Inbox Item.
• DeactivateInboxItem: Deactivates all Inbox Item Owners for an Inbox Item (makes them

read-only) and marks them “Completed”.
• DeactivateInboxOwner: Deactivates a specific Inbox Item Owner for an Inbox Item and 

marks it “Submitted”.
• DeleteInboxItem: Delete an Inbox Item and all associated Inbox Item Owners.
• GetInboxItemInfo: Returns field values from an Inbox Item, and, optionally, the name-value 

pairs of the user parameters.
• GetInboxOwnerInfo: Returns field values for multiple Inbox Item Owners for a specified 

Inbox Item, and their action status.
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Universal Inbox Business Service Methods (continued)

• GetInboxOwnerInfoEx: Returns field values for a single Inbox Item Owner.
• GetInboxParamInfo: Returns name-value pairs of user parameters for an Inbox Item.
• Initialize: Obsolete. Included for backward compatibility.
• IsInboxItemExisted: Returns 1 if an Inbox Item exists, 0 otherwise.
• RouteInboxItem: Obsolete. Included for backward compatibility.
• SetInboxParamInfo: Set name-value pairs of user parameters for an Inbox Item.
• UpdateInboxItemInfo: Update field values for an Inbox Item.
• UpdateInboxOwnerInfo: Update field values for an Inbox Item Owner.
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3.1. Business
Service
Updates
Object

Inbox: Outbound Architecture

• To move items from the Inbox:
– An Inbox action invokes a workflow or a business service
– This workflow or business service:

— Updates the feature object
— Uses a Universal Inbox Business Service method to update the 

Inbox Item

1. User
Selects
Action

Inbox
Type

3.2. Business
Service
Updates

Inbox Item

2. Action
Invokes

Business
Service
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Configuring the Inbox

To configure the Inbox to support your item:
1. Design the Inbox process flow
2. Create the Inbox type

1. Specify the name and translations
2. Specify the business object and destination view(s)
3. Specify the Action Type
4. Specify the Action(s)
5. Specify the Queue and Expiration durations
6. Specify the category, replication level, and other options

3. Create a workflow to add items to the Inbox
4. Create a workflow to process Inbox actions
5. Test the Inbox More
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1. Design the Inbox Process Flow

• Determine:
– On what business object will the Inbox item be based?

— For example, Service Agreements
– How will items be added to the Inbox?

— For example, a runtime event invoking a workflow or 
Assignment Manager

– To whose Inbox will the items be added?
— Only one user or to their manager as well?

– What actions are available on the Inbox item?
– When is that Inbox item considered “complete”?
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2.1. Specify the Name and Translations

• Specify a name for the Inbox type
– Used in Administration - Inbox > All Inbox Types view

• Specify language-specific translations
– Used in More Info applets of Inbox views
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2.2. Specify the Business Object and Destination 
View(s)

• To specify the destination view when a user drills down on 
an Inbox item:
– Specify a business object (BO) for the Inbox type

— All destination views must be associated with this BO
– Specify one or more views and sequence numbers

— The user is navigated to the lowest sequence view to which they 
have access

– Optionally, specify a SmartScript to be invoked
— Invoked within the context of the specified view

Destination views must be 
based on this business object

Specify at least one destination view
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2.3. Specify the Action Type

• Specify an LOV type to use for the available list of actions
– Selected action is passed as a parameter to the workflow or 

business service invoked when the action is selected

LOV Type is 
UINBOX_STATUS_TYPE

LOV definition in LOV 
administration view

Available actions on 
Inbox item of that type
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2.4. Specify the Action

• When a user selects an Inbox action, that action invokes a 
specified business service
– Frequently the Workflow Process Manager business service 

to invoke a specified workflow
– Specify the business service, method, and arguments

When an action 
is selected…

…invoke a workflow… …with these arguments

2.4. Specify the Action
Business Service Method Arguments: In addition to the arguments you specify in the Business 
Service Method Arguments field, several arguments are passed to the business service, including 
Action LIC, the language-independent code for the action the user selects. The business service (or 
workflow) is then responsible for branching based on that action; for example, marking a service 
request as Closed should mark the Inbox Item as complete, while marking it as Pending should leave 
it in the user’s Inbox. For a complete list of the arguments passed to the action business service, see 
“Setting Up Inbox Actions” in the Siebel Applications Administration Guide on Oracle Technology 
Network.
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2.5. Specify the Queue and Expiration Durations

• The Default Queue Duration determines a due date for an 
item
– If the Queue Duration expires without an action, the item is 

marked “Past Due”
– No other action is taken

— For example, to make a “Past Due” event send an e-mail to the 
Inbox Item Owner’s manager, you must configure that event

• The Item Expiration Duration determines an expiration 
date for an item
– The expiration date is shown in the Submitted Items view
– By default, no action is taken when an item expires
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2.6. Specify the Category, Replication Level, and 
Other Options

• The Category determines the icon shown next to the Inbox 
item
– For new icons, use Siebel Tools to create a new bitmap 

record for the Bitmap Category :: Inbox Category
– If no bitmap is specified, the text appears instead

• The Replication Level determines whether the Inbox items 
are copied to the local database:
– None: Inbox Items of that type are only available in the 

master server database
– Regional: Inbox Items of that type are available in the master 

server database, and regional databases
– All: Inbox Items of that type are also available in local 

databases
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2.6. Specify the Category, Replication Level, and 
Other Options

• The Transferable checkbox allows users to transfer Inbox 
items to a different user
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3. Create a Workflow to Add Items to the Inbox

• Could also use scripts or runtime events
• Configure enough process properties to invoke the 

Universal Inbox methods
– For example: Inbox type, Inbox item recipient, recipient’s 

manager, item owner, item Id, and so forth
– Check each method’s object definition to find its arguments

The IsInboxItemExisted 
method of the Universal 
Inbox business service 

checks for existing items

The CreateInboxEx 
method of the Universal 
Inbox business service 

creates a new Inbox item
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4. Create the Workflow to Process Inbox Actions

• When a user selects an action, it invokes a business 
service
– Typically the RunProcess method of the Workflow Process 

Manager business service
• This business service or workflow must correctly handle 

the action

Workflow determines 
selected action and takes 

appropriate measures
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5. Test the Inbox

• Test all possible permutations
– Test all possible user actions
– Test all possible manager actions
– Test all possible administrator actions

• Intentionally try to cause exceptions
– Submit items with empty fields
– Submit items with invalid values in the fields
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Lesson Highlights

• Users use the Inbox to view their notification and approval 
items
– They may take actions on Inbox items

• Configure the Inbox by:
– Creating an Inbox type
– Creating a workflow to populate the Inbox
– Creating a workflow to process Inbox actions
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Practice 8 Overview: 
Configuring the Inbox

This practice covers the following topics:
• Populating the Inbox
• Performing actions from within the Inbox
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Using Siebel Data Validation Manager
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Objectives

After completing this lesson, you should be able to:
• Describe the features of Siebel Data Validation Manager 

(DVM)
• Create and administer data validation rules
• Invoke DVM from a workflow process
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Data Validation Challenge

• Companies often place requirements on customer data to 
enforce business processes
– Examples:

— Any Quote with a discount more than 10% from the price list 
must specify an approving manager and a justification

— A service request must have a customer callback number
— An Opportunity must have a sales stage

• Validation requirements may be complex:
– The validity of a record may depend on one or more field 

values
– Validation requirements may change quickly
– Data validation may need to be monitored to gauge 

employee familiarity and compliance with business 
processes
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Data Validation Solutions in Siebel Applications

• Siebel applications support data validation with:
– Application configuration using business component field 

properties:
— Validation: specify field validation rules
— Validation Message: a string that can be displayed for invalid 

field values
– Siebel Data Validation Manager (DVM)

— The subject of this lesson
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Siebel Data Validation Manager (DVM)

• Comprises the Data Validation Manager business service 
and a screen for administering validation rules and 
messages

• Allows:
– Defining validation rules in an administration view
– Building complex rules using Siebel Query Language
– Displaying custom error messages
– Logging validation events

Custom error 
messages

Reference
Data Validation Manager is discussed in Bookshelf’s Siebel Order Management Infrastructure 
Guide, “Data Validation Manager”.
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Data Validation Manager Business Service

• DVM is a business service that has a single method, 
Validate
– Invoke the DVM business service in a workflow, Siebel task, 

or in an runtime event action set
• The Validate method uses validation data, created in the 

Siebel client, to check the validity of a specified business 
object
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One

DVM Administrative Data: Overview

Actions

Rule Set

Rules Rule Set
Arguments

Many

Many

Many

One One

• Validation data used by DVM:
– A validation rule set is one or more rules which operate on a 

specified business object and business component
— Rules are written in Siebel Query Language and are evaluated on 

invocation of the rule set
– Actions may be invoked when a rule evaluates to FALSE

— FALSE indicates that a validation error has occurred
– Rule set arguments are predefined arguments which may be 

used in a rule definition

DVM Administrative Data: Overview
Siebel Query Language is the language used to create search specifications and other similar 
expressions in Siebel Tools and the Siebel client. The syntax of this language, as well as descriptions 
of its operators and functions, is discussed in Bookshelf’s Siebel Personalization Administration 
Guide, Appendices A and B.

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Oracle
 In

ternal &
 O

racle
 Aca

demy

Use
 O

nly



Siebel 8.1.x Business Automation   9 - 8

Copyright © 2010, Oracle and/or its affiliates. All rights reserved.

DVM Execution

Define Data Validation
Rules in Admin View

Runtime events,
workflow, custom
control, or script

Application
Invokes DVM

DVM Business
Service

DVM Business Service
Evaluates Validation Rules

Pop-Up Error
Message

Log Validation Event
(Optional)

User-defined Action
(Optional)

Created during 
application 

configuration 

Actions

DVM Execution
Invoking the DVM business service is discussed in more detail later in this lesson.
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Creating Validation Administrative Data

To create validation rules:
1. Create a Data Validation Rule Set
2. Set Rule Set Options
3. Create Data Validation Messages
4. Add Data Validation Rules
5. Associate Validation Messages with Rules
6. Add Actions to Rules
7. Specify Rule Detail
8. Activate the Rule Set

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Oracle
 In

ternal &
 O

racle
 Aca

demy

Use
 O

nly



Siebel 8.1.x Business Automation   9 - 10

Copyright © 2010, Oracle and/or its affiliates. All rights reserved.

1. Create a Data Validation Rule Set

• Navigate to Administration – Data Validation > Rule Sets
• Specify:

– Rule set name
– Business object and business component to be validated

Rule sets are 
versioned

Specify business object 
and business component 

In Progress 
during creation
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2. Set Rule Set Options

• Use the detail applet to set rule set options: 
– Start and End Date: activate and deactivate rule set by date
– View: restrict validation to data entered in a specific view
– Conditional Expression: allows multiple rule sets per 

business component
— Example: different validation rule sets for service requests with 

different areas or products

2. Set Rule Set Options
Two other options are shown in the picture above:

• Group - A tag that can be used to group multiple rule sets. The group name can be passed as a 
parameter to the DVM business service Validate method, and DVM will evaluate all relevant 
rules in the group.

• Aggregate Errors - This flag overrides rule-specific settings about displaying validation 
messages (discussed on a later slide).  If a record violates multiple validation rules, then all 
related validation messages will be displayed if this flag is set.
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3. Create Data Validation Messages

• Navigate to Administration - Data Validation > Validation 
Messages

• Create validation messages with:
– Message Code
– Message Source and Message Level
– Message Text

3. Create Data Validation Messages
Message Code
A message code does not need to be unique, but should be easily tracked, as it may be associated 
with one or more rules (covered in an upcoming slide).  
Message Source and Message Level
Message source describes the business process that the message belongs to and the message level 
identifies which part of this process the message is associated with.  These two fields can be used to 
organize a complex set of validation messages.
Example: Message Source is AUT Order and Quote Validation, which is the name of our business 
process. Message Level could be Order or Quote, depending on which business component the 
validation message applies to.
Localization
Validation messages include multi-language support. The Validation Messages view has a child 
applet where message translations can be entered.
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4. Add Data Validation Rules

• Drill down on the rule set name in the Rule Sets applet
• Create rules and specify:

– Sequence #: determines the order of rule evaluation
– Name: a string that names the rule
– Expression: An expression in Siebel Query Language

— If using a business component field, you must know its name
— May not correspond to the list column name or form control label

– Return Code: discussed on next slide

Enter expression or click the 
select control to bring up the 

Expression Designer

4. Add Data Validation Rules
The Expression Designer is a Java applet to help you build expressions in Siebel Query Language. 
This tool provides easy access to business component fields, operators, and functions, and supports 
construction of complex expressions. You will use the Expression Designer in a practice for this 
lesson.
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5. Associate Validation Messages with Rules

• For each rule, specify a Return Code that matches the 
Message Code for the correct validation message 
– Click the Select control to choose the code from a pick applet

Use Return Code to associate a 
rule with a validation message

Select a 
message
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6. Add Actions to Rules

• Select the Actions tab in the applet below the Rules applet
• Optionally, specify one or more actions for a rule
• Action can be:

– Update a business component field
– Invoke a business service method

Update a BC 
field or call a 

business 
service method

If updating a BC field, 
specify field and value

6. Add Actions to Rules
Example
The screenshot in this slide shows both types of action for a rule. The first action results in update of 
the Service Request Status field to “Needs Correction”.  The second action results in invocation of 
the InsertAndQuery method for the ServiceReqEMHelpDesk business service. Both actions would 
run after their parent rule evaluates to FALSE.
Business Service Context
If an Action is to invoke a business service method, you can also specify input argument names and 
values to be passed to the method by using the Business Service Context field (not shown).
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7. Specify Rule Detail

• Select Rule Detail in the applet below the Rules applet
• Enter rule options:

– Stop on Error: if set and the rule is FALSE, then do not 
evaluate additional rules in the rule set

– Immediate Display: if set and the rule is FALSE, then 
immediately display the rule’s error message

7. Specify Rule Detail
The rule set option Aggregate Errors will display all validation messages for a record, and will 
override the Stop on Error rule option. Instead of stopping after the first validation error, DVM will 
evaluate all rules in the rule set and display all validation messages that are triggered.
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8. Activate the Rule Set

• After defining all rules, return to the Rule Sets list applet
• Click Activate

– Rule set Status changes to Active
– An active rule set can be modified by clicking Revise

— A new version is created and marked In Progress
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Invoking Data Validation Manager

• Siebel Customer Order Management includes built-in 
support for DVM invocation for Orders and Quotes
– Includes quote and order validation that can be invoked from 

the user interface
• Because DVM is a business service, it can be invoked by:

– A workflow process
– A Siebel task (covered in another lesson)
– A run-time event
– A custom control

Pre-built quote verification invokes 
the DVM business service

Invoking Data Validation Manager
Customer Order Management

• Siebel Customer Order Management is a comprehensive set of products that supports product 
administration, quote-to-order, and pricing.

Invoking DVM in a Workflow or Task
• The DVM business service can be added as a step in a workflow process or task. 

Invoking DVM from a Runtime Event
• A call to the DVM Validate method can be added directly to the action set for a runtime event. 

Runtime events and their action sets are administered in the Administration - Runtime Events 
screen.  For more information on runtime event administration, refer to Bookshelf’s Siebel 
Personalization Administration Guide.

Invoking DVM from a Custom Control
• A toolbar item, such as a button, or a menu item can invoke a Command object, which can call 

the DVM business service. This is similar to invoking a workflow process from a custom 
control, which is covered in another lesson. 
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Input Arguments for the DVM Business Service

• When invoking the DVM business service’s Validate 
method, use the optional input arguments:
– Rule Set Name: evaluate this rule set
– Group: evaluate all rule sets in this group
– Active Object: if Y, then use the current active business 

object; otherwise, you must specify the business object and 
the Id of a record of the corresponding BC

— Example: specify the Service Request business object and the 
Id of a Service Request record

– Enable Logging: if Y, then log all rule set evaluations

Example input arguments to 
the DVM Validate method
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Viewing Validation History

• If logging is enabled for DVM, view validation events in 
Administration - Data Validation > Validation History

• The validation history displays all rule set evaluations with 
status and error messages, if any
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Importing and Exporting Rule Sets

• Rule sets can be exported to an XML file and then 
imported to another Siebel server
– Example: Can be used to migrate validation rule sets from 

QA to Production servers

Importing and Exporting Rule Sets
There is no pre-built Application Deployment Manager (ADM) support for rule sets, validation rules, 
or validation messages. ADM is extensible, and ADM support for these DVM data types can be 
added.  See Bookshelf’s Siebel Application Deployment Manager Guide for information on how to 
add data types to ADM.
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DVM Considerations

• DVM can be used as an alternative to creating validation 
properties as part of application configuration
– Configuration example: define BC field validation properties

• Tradeoffs:
– DVM is more flexible and can handle quickly-changing 

business requirements without costly reconfiguration
– BC field validation is faster than validation using DVM

• Important note for DVM: make sure to run performance 
tests using all anticipated rule sets
– Measure scalability by testing with a maximum number of 

users
– Consider using BC field validation for validation requirements 

that are unlikely to change 
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Lesson Highlights

• Siebel Data Validation Manager (DVM) evaluates user-
defined data validation rules
– Can define or modify validation rules without application 

reconfiguration
– Validation rules can incorporate complex logic

• Organize validation rules into rule sets
• Validation rules should evaluate to FALSE on rule violation

– Optionally, update business component fields or invoke a 
business service method

• Invoke DVM by executing the DVM business service from:
– A workflow process
– A Siebel task
– A run-time event
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Practice 9 Overview: 
Using Data Validation Manager

This practice covers the following topics:
• Creating validation messages and a validation rule set
• Invoking DVM in a workflow process
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Siebel Task UI
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Objectives

After completing this lesson, you should be able to:
• Describe the features of Siebel Task UI
• Invoke and complete a task 
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Business Challenge

• Many tasks require users to perform several steps to 
complete the task
– Users may not be familiar with the sequence of steps
– Users may inadvertently skip a step
– Users often require additional training to complete the task 

• Companies would like to implement a user interaction style 
that assists users in completing such tasks
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Business Solution: Siebel Task UI

• Uses a wizard-like interface to guide users through steps 
in a task
– Consists of a sequenced set of views, each of which collects 

a small set of relevant data from the user
• Extends business process automation to the UI layer

Business Solution: Siebel Task UI
Siebel Task UI extends business process automation to the UI layer as Task UI allows 
developers to build tasks that direct users through a series of task views in a prescribed order.
Siebel Task UI also replaces the use of Interactive Workflows.
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Features of Siebel Task UI

• Task UI supports:
– Forward and backward navigation through a sequence of 

views
— Allows for a set of records to be reviewed and corrected prior to 

completion of the task
– Branching based on user input
– Pausing and resuming tasks if users are interrupted

— An instance of the partially completed task is saved in the user’s 
universal inbox

— Context and all data are maintained
— Task is resumed from the universal inbox 

– Transfer of paused tasks to other users

Features of Siebel Task UI
Task UI
Task UI refers to both the wizard-like style of the user interface as well as to the underlying 
Task UI framework that consists of the development, run-time, and administrative features that 
support this type of user interface
Task
The term task (in the context of Siebel Task UI) refers in general to a unit of work to be 
performed by a user as part of larger business process. The term task is also used to refer to a 
specific task developed using the Task UI framework. 
Bookshelf uses the term "task UI" to refer to a task as created by a developer. This course uses 
the term task.
Reference
“Overview of Siebel Task UI” in Siebel Business Process Framework: Task UI Guide
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Using Task UI

• Click the Task button to expose the task pane
– Displays links to tasks that can be invoked in the current 

application context
Task button

Task link

Task 
pane

Task group 
(a collection 

of related 
tasks)

Using Task UI
Task Group
A task group can be associated with a specific view or can be configured to appear in all regular 
views. An individual task is also assigned to a responsibility and a task link will appear only for 
users with the corresponding responsibilities. 
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Invoking a Task

• Click the link for the desired task
– A task view replaces the standard Siebel view
– Task pane displays other views in the task

— Provides context for the overall task

• Enter data in fields in the first view
• Click Next to proceed to subsequent views

Enter data

Task pane shows 
current position in task

Click Next 
to proceed

Invoking a Task
Reference
“Siebel Task UI Interface Elements” in Siebel Business Process Framework: Task UI Guide
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Invoking a Task

• Task views are typically characterized by:
– Small number of fields in each applet in the view
– A set of navigation buttons (the playbar applet) located 

above and/or below the applets
– Absence of navigation options such as view tabs and 

hyperlinks

Playbar applet

Small number of 
related fields

Task view
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Progressing Through a Task

• Enter data in each subsequent view
• Click Next to proceed
• Click Previous to return to the prior view to inspect or 

modify previously entered data

Task views in a chapter 
are listed as the user 
navigates to the view

Progressing Through a Task
Task Chapter
A task chapter is an optional grouping of sequential task steps. When task chapters are 
configured, only the task chapters are shown at first in the task pane. When a user reaches a task 
step in a task chapter the chapter is expanded and all the steps in that chapter are then displayed. 
Task chapters provide a mechanism for showing the high-level flow.
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Branching in a Task

• Tasks can branch based on data the user inputs
– Example: branching based on lead quality of an opportunity

• Some views may explicitly present the user with a choice 
about the next step to be executed
– Select the desired activity and click Next

User makes a selection
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Pausing a Task

• Click Pause to suspend task activity
– All data and context is retained
– A link to the paused task is added to the user’s inbox

• Navigating outside the task view implicitly pauses a task 
– For example, clicking a screen tab or the site map button 

Inbox
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Resuming a Task

• Click the link in the Inbox to resume the task
– Task resumes exactly where it was paused

Inbox

Task view 
reappears

Resuming a Task
Users can  navigate to their Inbox by clicking the link at the bottom of the task pane. Also they 
can use the site map to navigate to the Inbox.
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Completing a Task

• Review the data if a final summary view is provided
• Click Submit or Finish to complete the task

– Commits all remaining uncommitted data to the database
• Task view closes and previous standard view is displayed
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Invoking Tasks

• Some tasks can be invoked from any view in a Siebel 
application
– Example: Create a new service request

• Some tasks may require data from a record in the current 
view of a Siebel application
– Such tasks:

— Must be invoked only from views that display the record
— Are referred to as contextual tasks

– Example: Update an existing service request
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Contextual Task

• A contextual task is associated with a business component
– Can only be invoked in a view that contains an applet that 

references the associated business component

Contextual task, 
appears only if the 
view has a contact 

applet

Contact record is 
passed to invoked task
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Visibility of Tasks

• Tasks can also configured to be:
– Associated with only one or several standard Siebel views 
– Restricted to a single application 

• In addition tasks are assigned in the Siebel client to one or 
more responsibilities
– Only users with the responsibility see the link for the task

Responsibilities 
assigned to a task
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Task Designer

• Siebel Tools includes a Task Designer used to create, 
examine, and modify Siebel tasks
– Contains a palette, workspace, and property windows

Palette of 
task steps

Property window 
(displays 

properties of 
selected item)

Workspace for 
editing task flows

Multi value property 
window (displays 

properties of child object 
definitions of selected item)

Task Designer
The Task Designer is very similar to the Workflow Designer and the two designers have many 
common steps.
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Task Flow

• Is an ordered set of steps in a task that:
– Displays a sequence of views to users
– Enables users to create and modify records
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Task Flow Steps

• Task flows contain a variety of types of steps

Task view step: 
displays a task 
view to the user

Subtask step: 
Invokes a 
subtask

Decision point step: 
allows branching in a 

task flow

Siebel operation step: 
operates on a 

business component

Task Flow Steps
Reference
“Defining Steps and Connectors” in Siebel Business Process Framework: Task UI Guide

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Oracle
 In

ternal &
 O

racle
 Aca

demy

Use
 O

nly



Siebel 8.1.x Business Automation   10 - 20

Copyright © 2010, Oracle and/or its affiliates. All rights reserved.

Committing Data to Storage

• All data entered during a task is initially stored in 
temporary storage managed by the Object Manager
– Is not written to the database as the user navigates

• Persistent data is committed to the database:
– When the task completes
– At intermediate points in the task flow if the underlying task 

flow contains explicit commit steps
• Records can not be rolled back after being committed
• Data is not available to others until it is committed
• Data in temporary storage:

– Is maintained while the task is paused 
– Is cleared only when the task is cancelled or completed
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Transient Data in Task UI

• Refers to data collected and used during the execution of a 
task but not saved afterwards
– Example: user choice about the next step

• Transient data may be mapped to persistent data in a later 
step in the task

• Transient data disappears when the task ends

User’s selection does not 
need to be stored persistently
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Comparison of Task and Standard UI

• Consider using Task UI for tasks that:
– Are inherently complex

— Lengthy, complex sets of inputs, lots of branching
– Are performed by novice or infrequent users
– Can take advantage of the ability to pause and transfer tasks
– Involve transactional processing 
– Might be integrated with workflows

• Consider using the standard UI for tasks that:
– Are simpler
– Are performed frequently by power users
– Do not involve transactional processing

Comparison of Task and Standard UI
Transactional Processing
In Siebel Task UI, transactional processing refers to a set of actions on multiple records that 
must finish successfully or be completely rolled back.  
In Standard UI, usually the action is on single record at a time.
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Lesson Highlights

• Siebel Task UI is a wizard-like interface that guides users 
through steps in a task

• Invoke a task from a link in the task pane
• Use the buttons in the playbar applet to proceed, return to 

the previous view, pause, or complete the task
– Paused tasks are resumed from the universal inbox

• Data collected during a task is not committed to the 
database
– Until the task is completed 
– Or is explicitly committed at specific points in the task

• Use the Task Designer to create, examine, and modify 
Siebel tasks
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Practice 10 Overview: 
Siebel Task UI

This practice covers the following topics:
• Executing a task
• Examining a task using the Task Designer
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Creating a Task
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Objectives

After completing this lesson, you should be able to:
• Configure a task
• Administer a task
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Creating a Task

• Consists of the following:
– Configuring task UI object definitions using Siebel Tools

— Task flow
— Task view
— Task group

– Deploying the task to the run-time client
– Administering the task in the run-time client

Creating a Task
Reference
“Defining UI Objects” in Siebel Business Process Framework: Task UI Guide
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Task View

• Is a special type of view used in a task
– Displays data to a user
– Allows a user to edit data

• Consists of one or more applets and the playbar applet
• Is invoked in a task view step in a task flow

Task view

Task 
view step

Task View
Reference
“Siebel Task UI Interface Elements” in Siebel Business Process Framework: Task UI Guide
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Task Views and Standard Views

• Task views differ from standard views
– View is not displayed in the context of a screen
– Must use buttons in the playbar applet to navigate

— Clicking any UI element outside the task view and task pane 
pauses the task and displays the prior standard Siebel view

– Applets in a task view do not have applet menus
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Task Group

• Represents a collection of related tasks that can be 
displayed as a set in the task pane

• Can be configured to be:
– Associated with a single standard view or available across all 

views
– Restricted to a single application or available across all 

applications

A task group
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Creating a Task

The steps to create a task are:
1. Create the task flow
2. Create applets for the task views
3. Configure the task views
4. Bind the task views
5. Configure additional steps
6. Assign chapters
7. Create the task group
8. Compile the configured objects
9. Publish the task flow

More
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1. Create the Task Flow

• Use the Task wizard to create a Task object definition

Select File > New Object, 
click the Task tab, and 

click Task

Identifies the 
business object 

for the task 

Name of task 
to appear in 

the task pane
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1. Create the Task Flow:
Add Task Steps

• In the Task Designer, add steps as required:
– Drag connectors and anchor them to steps

1. Create the Task Flow: Add Task Steps
The Task Designer is similar to the Workflow Designer used to build workflow processes.
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2. Create Applets for the Task Views

• Use the Form Applet wizard to create applets that display 
a small set of focused data

• Alternatively, copy an existing applet and delete 
unnecessary fields
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3. Configure the Task Views

• Use the Task View wizard to create the task views
– Creates a view with type = Task

Select File > New Object, 
click the Task tab, and 

click Task View

Identifies the 
business object 

for the view 

View name 
that appears 
at the top of 

the view
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3. Configure the Task Views

• Use the Task View wizard to create the task views
– Select a view Web template
– Assign one or more customized applets
– Add the Playbar applet to the top and/or bottom of the view

Several different
playbar applets to 

select from
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4. Bind the Task Views

• For each task view step in the flow, assign a task view
– Right-click the task step and select Bind Task View
– Select the view from the list of available task views
– Set the button properties for the view 

Determine whether
playbar buttons are 
enabled or disabled Set to Next for 

most task views

4. Bind the Task Views
Forward Button Type
The forward button type property determines the text that appears in the button users click to 
advance or complete the task. It does not determine the behavior of the task; rather it suggests to 
the user what will next happen. The button property can be Next, Submit, or Finish.
Submit should be used to indicate that the temporary data transaction for the task is about to be 
committed to permanent storage for enterprise wide consumption and, when committed, cannot 
be rolled back.
Finish indicates that clicking the forward navigation button ends the task. It must be used only in 
a task where the task transaction is fully committed before the last view.
Next indicates the task proceeds with data still in temporary storage.
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5. Configure Additional Steps

• Configure other types of steps such as:
– Siebel Operation

— Performs the following operations on a business component
— Insert
— Delete
— Update
— Upsert
— Query

– Decision Point step
– Subtask Step

Discussed in 
subsequent lessons
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5. Configure Additional Steps: 
Configuring a Siebel Operation Step

• Specify the business component and operation
• Set the Defer Write property to TRUE to allow the task to 

proceed without any required fields being entered in the 
first step

5. Configure Additional Steps: Configuring a Siebel Operation Step
Defer Write Record Property
Setting the Defer Write Record property to True allows a task to collect all the required fields 
for a business component in several different task views before the record is committed to 
permanent storage. In particular it allows an insert Siebel operation step to appear prior to a task 
view in which a user first enters data for the business component
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6. Assign Chapters

• Optionally, create chapters to group steps in the task pane
• Assign each step to a chapter

Assigned to chapter 2

Assigned to 
chapter 1
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7. Create the Task Group

• Assign the Task to an existing (or new) Task Group
– Groups several tasks in the task pane

• Assign the Task Group to a view 
– Assign to Task Pane View to make tasks visible in all views

1. Assign task 
to task group

2. Assign task 
group to view

Restricted to a 
single application

7. Create the Task Group
A task can be assigned to several task groups if required. A task group can be assigned to several 
views.
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7. Create the Task Group: 
Assign Context Business Component

• For tasks that require a context business component
– Set the Require Context BC property in the task group to 

TRUE
– Identify the context business component for the task group 

item

The context business 
component is the business 
component associated with 

a contextual task
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8. Compile the Configured Objects

• Compile the configured objects into the target SRF file
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9. Publish the Task Flow

• First, validate the task flow to identify any possible errors
– Right-click and select Validate

9. Publish the Task Flow
A task object definition is not compiled, so it can be validated and deployed after the views and 
applets have been compiled. 
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9. Publish the Task Flow

• Click the Publish button in the Deployment toolbar to 
deploy the task flow
– Sets the task flow to complete
– Makes it available for activation
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Administering a Task

The steps to administer a task are:
1. Activate the task flow
2. Register the task flow
3. Assign responsibilities 

More
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1. Activate the Task Flow

• Navigate to Administration - Business Processes > Task 
Deployment

• Select the published task and click Activate
– Makes the task available for use in the client

• Alternatively Publish/Activate directly from Siebel Tools

Activated 
tasks

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Oracle
 In

ternal &
 O

racle
 Aca

demy

Use
 O

nly



Siebel 8.1.x Business Automation   11 - 24

Copyright © 2010, Oracle and/or its affiliates. All rights reserved.

2. Register the Task Flow

• Navigate to Application - Administration > Tasks
• Create a new record and select the task from the list of 

published tasks
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3. Assign Responsibilities 

• Add one or more responsibilities to the registered task
– Allows users with the responsibility to see the task in the task

pane
– Click Clear Cache to update the cache

Adds the task to 
this responsibility
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Testing the Task

• Navigate to a view to which the task is assigned
• Click the Tasks button to display the task pane

– Verify that the desired task appears
– Verify that the task link appears only for:

— Users with an assigned responsibility
— Assigned views if so configured

• Click the task link and execute the task
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Lesson Highlights

• Creating a task in Siebel Tools consists of:
– Configuring a task flow

— Creating and binding task view steps
— Assigning steps to chapters

– Adding the task to a task group
– Assigning the task group to a view
– Publishing the task to the run-time client

• Administering the task in the run-time client consists of:
– Activating the task
– Registering the task
– Adding the task to one or more responsibilities
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Practice 11 Overview: 
Creating a Task

This practice covers the following topics:
• Creating a task
• Deploying and administering the task
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Transient Business Components
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Objectives

After completing this lesson, you should be able to:
• Describe the role of transient business components and 

task applets
• Configure branching logic in a task 
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Transient Data

• Refers to user-edited data that:
– Is processed by subsequent steps in the task
– Does not need to be stored persistently after the task 

completes
• Examples:

– Selection made by a user to determine task flow
– Data entered by a user that may be processed before being 

stored in a regular business component

Transient Data
Reference
“Reference Materials for Siebel Task UI” in Siebel Business Process Framework: Task UI 
Guide

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Oracle
 In

ternal &
 O

racle
 Aca

demy

Use
 O

nly



Siebel 8.1.x Business Automation   12 - 4

Copyright © 2010, Oracle and/or its affiliates. All rights reserved.

Transient Business Component (TBC)

• Is a special type of business component used to store 
transient data
– Type is transient
– Has one or more single value fields
– Does not support joins or multi value fields

• Is managed by the Object Manager
– All transient business component records are stored in a  

special table: S_TU_LOG
– Transient business component records are automatically 

deleted upon committing data or canceling a task
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Configuring a Transient Business Component

• A TBC can be configured as either:
– A single record TBC that can store one and only one record

— Example: a TBC to store the user's "next" choice
– A multi-record TBC that can store one or more records

— Example: A TBC to store one or more proposed offers before 
one is selected to be stored persistently

• Always use the Transient BusComp wizard to create a TBC
– Ensures that class and other properties are set as required

Configuring a Transient Business Component
Transient Business Components
A single record TBC uses the CSSBCTaskTransient class while a multi-record TBC uses the 
CSSBCTaskTransientBase class.
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Task Applet

• Is a special type of applet used to display and collect 
transient data
– Maps to a transient business component
– Displays data from only that business component

• Can be assigned only to a task view
– Can appear in a view by itself or with one or more standard 

applets

Example of a 
task applet

Task Applet
Reference
“Siebel Task UI Interface Elements” in Siebel Business Process Framework: Task UI Guide
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Types of Task Applets

• A task applet is either a:
– Task form applet to display a single record TBC

— Based on the specialized class CSSSWEFrameTask
— Uses the Applet Form Grid Layout Web template 

– Task list applet to display a multi record TBC
— Based on the specialized class CSSSWEFrameTaskList
— Uses the Applet List Grid (Base/EditList) Web template
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Uses for a Transient Business Component

• Capture user selections that control the flow of a task at 
run-time  
– Discussed in this lesson

• Collect data that may be incorporated into persistent data 
later in the task
– Example: collect data about a contact and then create the 

contact if the contact does not already exist
– Discussed in a later lesson

• Support applets that display data from several business 
components
– Example: an applet that needs to show both quote and order 

fields
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Branching in a Task

• The Task UI framework supports branching in a task 
based on user input
– Selection can be persistent data such as the account type
– Selection can be transient data such as the "next" choice

— Requires the use of a transient business component

• Is implemented by configuring a decision point step

Task flow with 
branching based 
on account type
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Configuring Branching in a Task Using a TBC

The steps to configure branching in a task are:
1. Extend the task flow
2. Create a picklist
3. Create the transient business component
4. Create the task form applet
5. Create the task view
6. Configure the decision point step
7. Complete the configuration
8. Test the task

More
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1. Extend the Task Flow

• Add a task view step to the flow to allow the user to make 
a choice

• Add a decision point step to process the user’s choice
• Add connectors to implement the desired business flow

– Example of direct branching
Task view to allow the 
user to make a choice

Decision point step 
to process choice

A separate task view for each user choice

Each branch corresponds 
to a member in a List of 

Values (LOV)
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1. Extend the Task Flow

• Example that involves looping or iteration

2. Decision point step 
to evaluate choice

4. Loop back 
to ask the 

user to 
choose again

3. Each branch corresponds 
to a member in an LOV

1.Task view to allow 
user to make choice
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2. Create a Picklist

• A pick list is required when a user is presented with a set 
of choices

• Select an existing pick list if available
• Alternatively create a new picklist 

– Represent the choices as members of a List Of Values type
– Configure the PickList object

Picklist 
records
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3. Create the Transient Business Component

• Use the Transient BusComp wizard to create the transient 
business component

Select only for 
multi record TBCs

Select File > New Object, 
click the Task tab, and 

click Transient BusComp
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3. Create the Transient Business Component

• Add one or more fields
– Assign name, type, and length as required
– Do not assign a column

— Will be assigned automatically after the record is saved
– If required, assign the picklist

— Create the single value field pick map

Assigned automatically 
by Siebel Tools

Provides choices for 
user selection
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4. Create the Task Form Applet

• Use the Task Applet wizard to create the task applet
– Identify the transient business component
– Identify the task in which the applet will be used
– Select the TBC field(s) that are to be displayed

Select File > New Object, 
click the Task tab, and 
click Task Form Applet

Display title for applet

Assigns applet to 
this task only

Specify the transient 
business component 

for the applet
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4. Create the Task Form Applet

• Inspect the applet in the Web layout editor
– Wizard assigns a radio button control for all fields

• For fields with picklist, a radio button control:
– Displays the members of the underlying LOV
– Allows users to select a value by clicking a radio button

• For other fields, manually change the HTML type to the 
desired value

• Reposition and/or resize the label and control for each field

Radio button 
control (displays 
the members of 

a LOV)

Control caption, 
can be edited to 

include instructions
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5. Create the Task View

• Use the Task View wizard to create a new task view
– Assign zero or more regular applets as required
– Assign the task form applet
– Select and position the playbar applet

• Alternatively add the task applet to an existing task view
– Drag a Task Applet icon from the Applet pane to an applet 

placeholder
– Select the desired task applet
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6. Configure the Decision Point Step

• Right-click the decision point step
– Set the name property to a meaningful value

• Right-click each connector leading from the decision point 
step
– Set the label property to a meaningful value as well
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6. Configure the Decision Point Step:
Compose Conditions

• Compose the conditions for each connector
– Right-click each connector leading from the decision point 

step and select Edit Conditions
– Select TBC, field, and desired value for this branch

TBC Field

LOV 
member
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7. Complete the Configuration

• Configure the remaining steps (task view, Siebel operation, 
and so on)

• For each task view step bind the corresponding task view
– Remember to set the Forward Button Type to Next

• Assign each step to a chapter
• Compile all new and modified objects
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8. Test the Task

• Validate the task
• Publish and activate the task
• Invoke the task in the client and verify that the task applet 

appears and branches as desired
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Lesson Highlights

• Tasks may include transient data
– Data entered by users that does not need to be stored once 

the task completes
• A transient business component is required to store data 

entered by a user that is not required after the task 
completes 

• A task applet is required to display data stored in a 
transient business component

• A task can include branching based on user entered 
values including transient data

• Branching requires adding a decision point step to the task 
flow
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Practice 12 Overview: 
Transient Business Components

This practice covers the following topics:
• Extending a task to include branching
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Additional Task UI Configuration
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Objectives

After completing this lesson, you should be able to:
• Explain the role of task properties
• Use task properties in task steps
• Configure queries in task steps
• Configure an instance identifier for the user inbox
• Configure a subtask
• Use the task debugger to examine task properties
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Task Properties

• Are variables that store data used by or produced by task 
steps
– Data persists while the task is executing

• Can be used to pass values:
– Between steps in a task
– To and from a business service
– To and from a subtask

• Can provide values for use in:
– Decision point steps
– Expressions such as search specifications used in Siebel 

operation steps 

Task Properties
Task Properties
Task properties play the same role that process properties play in workflow processes.
Reference
Reference Materials for Siebel Task UI” in Siebel Business Process Framework: Task UI Guide
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System Task Properties

• Each task, by default, has a set of system task properties
• View the task properties for a task in the multi value 

property window (MVPW)
– If necessary, click the Task Properties tab
– Make sure that no task step has been selected

System Task Properties
Several of the task properties (Object Id, Siebel Operation Object Id, Error Code, and Error 
Message) are the same as the corresponding process properties for Siebel workflow processes. 
The remaining task properties are specific to tasks.
Task Property is a child object type of Task and appears in the MVPW when the task itself is 
selected. If another item such as Task View Step or Decision Point step is selected, a different 
set of child properties appear in the MVPW.
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Configuration Involving Task Properties

• Some tasks may require configuration of task properties:
– Using and storing values of transient business component 

fields
– Creating search specifications for task steps
– Configuring contextual tasks
– Creating an instance identifier for display in the task inbox
– Configuring a subtask

More

Configuration Involving Task Properties
Many tasks can be created without the need to create or refer to task properties. This is in 
contrast to creating workflow processes which typically involve creating and using workflow 
process properties.
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Transient Business Component Data

• Can be manipulated in a task view step that includes a 
task applet based on the TBC

• Can be directly accessed in conditions for decision point 
steps

• Must first be assigned to task properties before:
– Being assigned to standard business component fields

— Required if some transient data needs to be stored persistently
– Being referenced in expressions

Transient Business Component Data
Data in a task property can also be considered transient. However, data in a TBC can be directly 
presented in the UI while task property data cannot. This difference is a factor when deciding 
whether to store transient data in a TBC or in a task property.
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Using Transient Business Component Data

The steps to use transient business component data are:
1. Create additional task properties
2. Assign TBC data to task properties
3. Assign task properties to input arguments

More

Using Transient Business Component Data
Reference
“Reference Materials for Siebel Task UI” in Siebel Business Process Framework: Task UI 
Guide
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1. Create Additional Task Properties

• Invoke the Task Designer for the task
• Click the Task Properties tab in the MVPW
• Create custom task properties to correspond to each TBC 

field that needs to be processed
– Specify the data type, access mode, and In/Out properties 

Custom task 
properties specific 

to this task

1. Create Additional Task Properties
The In/Out property defaults to none for a new task property. You can change it to In, Out, or 
In/Out if you need to pass data into or out of the task. This does not typically occur for tasks that 
are invoked directly by a user.
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2. Assign TBC Data to Task Properties

• Select the task view step that includes a task applet
• Create output arguments for each field to be assigned

– Click the Output Arguments tab in the MVPW
– Select the task property and specify the source business 

component and field

… is assigned the value in this 
field in this business component

Task property…
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3. Assign Task Properties to Input Arguments

• A value in a task property can be stored persistently by 
assigning it as an input to a Siebel operation step
– Select the Siebel operation step
– Click the Fields tab in the MVPW
– Assign the task property to the desired field 

Siebel operation step 
to store values 

This field … … is assigned the value 
of this task property
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Search Specifications in Tasks

• Some tasks may include a task step in which a set of 
records is retrieved and displayed
– Involves creating a search specification 

Task view that displays all 
service requests for a contact  
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Task Step Context

• Is a child object type of task step used to specify a search 
specification
– Includes an expression based on literals, field values, and 

task property values 
• Can be created for task views and Siebel operation steps

Retrieves contacts with first and 
last names that match 

corresponding task properties 

Task Step Context
Reference
“Building a Task UI” in Siebel Business Process Framework: Task UI Guide
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Creating a Search Specification

• Select the task view or Siebel operation step
• Click the Task Step Context tab in the MVPW
• Create a new record and assign properties

Literal or 
expression 

Specifies the BC whose fields 
might be referenced in the 
right side of the expression 

Specifies the BC being queried 
(fields on left side of expression)

Uses similar syntax to refer 
to task properties as is used 

for workflow processes
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Contextual Tasks

• Several system properties are populated automatically 
when a contextual task is invoked
– Object Id and Context BC Id are populated with the Row Id of 

the context record
— Passes in the record to the task
— Populates the fields of the primary business component

Contextual 
task 
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Configuring a Contextual Task

• Specify values for the Context BC Name and Context BO 
Name task properties to identify the context for the task
– Can be omitted if the task is invoked only from views in 

which the task business object = view business object

Configuring a Contextual Task
Context for the Task
The context for the task refers to the business component that is passed into the task when a 
contextual task is invoked.
Reference
“Siebel Task UI Interface Elements” in Siebel Business Process Framework: Task UI Guide
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Resuming Tasks from the Inbox

• Tasks can be paused and then resumed from the universal 
inbox

• By default tasks are identified by the task name
– May be hard to identify the desired instance to resume
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Inbox Context Field

• Is a field in an inbox record that can be used to distinguish 
among multiple-paused instances of a given task

• Can be populated with instance-specific data such as:
– Name
– Timestamp

Instance identifier 
to  distinguish the 

paused tasks

Inbox Context Field
Reference
“Building a Task UI” in Siebel Business Process Framework: Task UI Guide
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Configuring an Instance Identifier

• Select an early step in the task
– Must be of a type that allows output arguments to be 

assigned
• Click the Output Arguments tab
• Create a record to assign a value to the Instance Identifier 

task property
– Assign an expression or business component field 
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Subtask

• Is a separately configured task that
– Is invoked as part of another task
– Cannot be invoked by itself

• Allows a large task to be partitioned into smaller tasks that
– May be easier to develop and maintain 
– Can be shared among different parent tasks

Subtask step

Subtask
Reference
Defining Steps and Connectors” in Siebel Business Process Framework: Task UI Guide
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Characteristics of Subtasks

• A subtask:
– Participates in the same task transaction
– Has access to business component fields in the parent task
– Must be based on the same business object
– Has its own set of task properties
– Can contain a subtask

Characteristics of Subtasks
Task Transaction
A Task Transaction refers to the set of persistent and transient data associated with the task 
instance while the task is executing or paused. It represents the data that has not yet been stored 
in the regular Siebel database tables.
Executing a Subtask
Invocation of a subtask is transparent to the user; the user receives no indication that a subtask 
has just been invoked or completed. In addition a user can navigate backwards, using the 
previous button from a subtask to a parent task.
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Configuring a Subtask

• A subtask:
– Is created in the same way as a task

— Check Create as a subtask in the New task wizard 
— Is Subtask flag cannot be changed once a task or subtask is created

– Is published and activated in the same way as a task
— Subtasks need to be published before the parent task
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Adding a Subtask Step

• Add a subtask step to the task
• Specify a display name for the step
• Assign a subtask

– Select from the list of subtasks in the drop-down list 

Adding a Subtask Step
Subtask steps have input and output arguments that you can configure, if required, to pass data 
into or receive data from a subtask. This is required if you wish to make task properties in the 
parent task available to the subtask, or make output arguments of the subtask available to the 
parent task.
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Task Debugger

• Siebel clients include a task debugger to assist developers 
in testing tasks
– Provides a watch window that displays values of task 

properties and business component fields

Task Debugger
Reference
“Testing and Troubleshooting a Task UI” in Siebel Business Process Framework: Task UI 
Guide
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Enabling the Task Debugger

• Adds a Debug Mode item to the Tools menu in a Siebel 
client
– For the Siebel Developer Web client:

— Edit the application configuration file
— Add, if necessary, a parameter called EnableRestrictedMenu
— Set it to TRUE

– For the Siebel Web client:
— Select the Siebel server in the server configuration 

administration screen
— Select the application object manager
— Set the EnableRestrictedMenu parameter to TRUE 
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Using the Task Debugger

• In the Siebel Client, select Tools > Debug Mode
• Invoke a task as usual

– The watch window appears and displays properties upon 
completion of the start step

When Debug mode 
is enabled ….

… the task debugger 
appears when a task 

executes
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Examining Task Properties

• Click Continue to advance through the task
– A task view is displayed whenever a task view step occurs

• Examine the contents of the watch window
Step 

completed

Task properties with 
populated values

Business components 
appear as they are created
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Examining Business Component Fields

• Expand each business component to examine the values 
of its fields as the task progresses
– Examine both regular and transient business components
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Lesson Highlights

• Task properties are variables that store data used by or 
produced by task steps

• Some tasks may require configuration of task properties:
– Using and storing values of transient business component 

fields
– Creating search specifications for task steps
– Configuring contextual tasks
– Creating an instance identifier for display in the task inbox
– Configuring a subtask

• A task debugger can be used to monitor task properties 
and business component field values as a task executes
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Practice 13 Overview: 
Additional Task UI Configuration

This practice covers the following topics:
• Using transient business component fields in a search 

specification
• Storing transient business component fields
• Calling a workflow from a task
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